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При использовании в первый раз

Что может делать с этим программным обеспечением?

Классификация
неподвижных изображений  
и движущихся  
изображений

Просмотр
неподвижных 
изображений 
и движущихся 
изображений

Выполнение
слайд-шоу

Создание DVD
из движущихся изображений AVCHD/AVCHD Lite 

Резервное 
копирование
данных неподвижных изображений и
движущихся изображений

Копирование с 
цифровой камеры на ПК
неподвижных изображений и движущихся изображений с 
помощью данного программного обеспечения 

Обработка
неподвижных изображений и 
движущихся изображений

Печать
неподвижных 
изображений

Пересылка
в Интернет

Отправление
по электронной 
почте
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При использовании в первый раз

 

 

Копирование записанных изображений на ПК и их отображение
В данном разделе описывается процедура копирования неподвижных изображений или движущихся изображений, записанных с 
помощью цифровой камеры, на ПК.

1 Подсоедините
цифровую камеру к ПК (→6) 2 Скопируйте

изображения (→7) 3 Просмотр
скопированных снимков (→9)

Советы
●●За более подробной информацией обратитесь к страницам, на 
которых приведено описание каждой функции.
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Копирование записанных изображений на ПК и их отображение
При использовании в первый раз

 

 

1 Подсоедините цифровую камеру к ПК (→16)
1 Запустите ПК.

2 Включите цифровую камеру.

3 Подсоедините прилагаемый 
соединительный кабель USB.

4 Установите цифровую камеру 
на соединение с ПК.
Отображается экран [Copy to PC].

Советы
●●Экран [Copy to PC] отображается только когда в окне настроек 
PHOTOfunSTUDIO включена функция автоматического запуска.
●●Если экран [Copy to PC] не отображается, выберите иконку 
PHOTOfunSTUDIO в окне автоматического просмотра Windows 
(окне выбора операции).
●●Если отображается окно, отличное от PHOTOfunSTUDIO, 
например, окно LUMIX Simple Viewer, щелкните [No], чтобы 
закрыть окно.
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При использовании в первый раз
Копирование записанных изображений на ПК и их отображение

2 Скопируйте изображения (→19)

2 Щелкните [Next].

1 Если имеются снимки, которые 
Вы не хотите копировать, 
щелкните и снимите с них метки.
При выборе квадратика в верхнем левом углу снимка 
снимок будет скопирован на ПК.

Копировать Не копировать

Советы
●●Функции данного программного обеспечения можно использовать 
при копировании изображений на ПК.
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При использовании в первый раз

Копирование записанных изображений на ПК и их отображение

3 Щелкните по папке назначения 
для копирования.

4 Выберите установку для 
вложенной папки, чтобы 
создать ее в папке назначения 
для копирования.
Например, если Вы выберите опцию [Day of acquisition], 
создается папка с сегодняшней датой, и снимки 
копируются в эту папку. 

5 Щелкните [Execute]. 

6 При отображении подтверждающего 
сообщения щелкните [Yes].
Снимки с цифровой камеры копируются на ПК. 

7 При отображении подтверждающего 
сообщения о завершении 
копирования щелкните [OK].

8 Щелкните [Close].
Отображается основное окно PHOTOfunSTUDIO. 

9 При отображении подтверждающего 
сообщения щелкните [Yes].
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При использовании в первый раз

Копирование записанных изображений на ПК и их отображение

3 Просмотр скопированных снимков (→36)
1 Щелкните по папке, которая 

содержит скопированные снимки.
Если вложенная папка не отображается, щелкните .

2 Поиск изображений.
Вы можете также выполнять поиск изображений, 
которые Вы хотите посмотреть, с помощью регулятора 
для увеличения уменьшенного изображения 
(миниатюры).

3 Дважды щелкните по изображению, 
которое Вы хотите просмотреть.
Отображается окно просмотра. 
Движущиеся изображения начинают воспроизводиться 
автоматически. 

●●Неподвижные изображения, записанные в режиме 
серии, которые отображаются в виде группы, будут 
развернуты для показа миниатюр.

4 Если Вы хотите посмотреть 
другой снимок, щелкните по 
миниатюре с левой стороны.

5 Щелкните по  для возврата к 
основному окну.

<Окно воспроизведения>
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Перед использованием

Введение
	Содержание данной инструкции
●●Пожалуйста, примите во внимание, что некоторые объяснения 
и изображения экранов, приведенные в этой инструкции по 
эксплуатации, могут отличаться от реальных изображений 
экранов и содержания. (Отличия также  могут иметь место в 
зависимости от рабочей среды Вашего ПК.)
●●Информация об основных операциях и терминах при работе 
на ПК не предоставлена. Пожалуйста, обращайтесь к 
соответствующим инструкциям пользователя для ПК.
●●Содержание данного руководства по эксплуатации может быть 
изменено без предварительного оповещения.
●●Полная или частичная репродукция данного руководства по 
эксплуатации без разрешения запрещена.
●●Описание Windows® в данном руководстве по эксплуатации 
основывается на окнах Windows Vista®.
●●В настоящей инструкции по эксплуатации за небольшим 
исключением используются изображения из версии 
PHOTOfunSTUDIO 5.2 HD Edition.
●●Версии этого программного обеспечения на английском, 
Француском, немецком, испанском и упрощенном китайском 
языках предусмотрены для ОС соответствующих языков. Если вы 
пользуетесь ОС на другом языке, для работы устанавливается 
английская версия.
●●Страницы, к которым рекомендуется обращаться, показаны как 
(→00).
●●В данном руководстве по эксплуатации PHOTOfunSTUDIO 5.2 HD 
Edition обозначается как “PHOTOfunSTUDIO”.
●●В данном руководстве по эксплуатации “карта памяти” 
подразумевает карту памяти SD, включая встроенную память.
●●Доступные для использования операционные пункты меню и 
меню с вызовом правым щелчком зависят от рабочего состояния 
PHOTOfunSTUDIO или состояния выбора снимков. Недоступные 
для использования пункты отображаются серым.
●●В зависимости от цифровой фотокамеры некоторые модели не 
оснащены такими функциями, как режим [РЕБЕНОК], режим 
[ДОМ.ЖИВОТНОЕ], опции [ДАТА ПОЕЗДКИ], [ОТПЕЧ.ДАТЫ], 
[ОТПЕЧ СИМВ], классификация по лицу (распознавание лица), 
файлы RAW или GPS, упомянутыми в данной инструкции.

	Меры предосторожности при использовании
●●Не вынимайте соединительный кабель носителя (карты памяти и 
DVD и пр.) или цифровой камеры во время их взаимодействия с 
данным ПО. Это может привести к неправильной работе ПО или 
повреждению передаваемых данных.
●●Если Вам не удается запустить PHOTOfunSTUDIO из-за 
нехватки системных ресурсов, закройте другие приложения и 
перезапустите PHOTOfunSTUDIO.
●●При выборе большого количества снимков потребуется время 
для показа их в виде миниатюр.
●●В зависимости от используемой среды миниатюра может 
отображаться неправильно, если количество отображаемых 
снимков превышает 10 000.

	О функции сети
●●Эта услуга доступна по состоянию на 1 мая 2010 г.
●●В дальнейшем работа в отношении услуг или изменений 
в технических требованиях YouTube™ не гарантируется. 
Пожалуйста, примите во внимание, что содержание услуги или 
применяемый экран могут измениться в любое время и без 
предупреждения.
●●Не загружайте движущиеся изображения, охраняемые авторским 
правом. Такие операции возможны в случае разрешения от 
соответствующего субъекта права либо при наличии собственных 
прав.
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Введение
Перед использованием

О персональной информации
Персональная информация об имени и возрасте добавляется к 
записанному снимку, если имя или дата рождения установлены в 
режиме [РЕБЕНОК] на цифровой камере.
Поскольку функция распознавания лица извлекает черты лица 
для классификации, информация о них и сам снимок лица будет 
сохранен на ПК.
Кроме того, заданная в снимке лица информация об имени и дне 
рождения сохраняется на ПК.

	�Управление персональной информацией и снятие 
ответственности изготовителя за нее
●●Информация, содержащая персональные данные, может 
изменяться или исчезать вследствие ошибочных действий, 
воздействия статического электричества, случайности, 
неисправности, ремонта или иных причин. 
Примите, пожалуйста, во внимание, что Panasonic ни в 
коем случае не несет ответственности за любой прямой или 
непрямой ущерб или утерю данных вследствие изменений или 
исчезновения информации, содержащей персональные данные.

	�Всегда стирайте персональную информацию при 
передаче информации другим лицам или при 
утилизации аппарата
●●Для защиты персональной информации всегда стирайте 
информацию с жесткого диска перед передачей аппарата 
другим лицам или перед утилизацией.
●●Использование команд ПК “форматировать” или “удалить” 
приведет только к изменению информации по управлению 
файла, но не сотрет полностью данные с жесткого диска. 
Рекомендуется физически разрушить жесткий диск или 
воспользоваться представленным на рынке программным 
обеспечением для стирания данных с ПК, чтобы полностью 
стереть данные с жесткого диска перед передачей другим 
лицам или перед утилизацией аппарата.
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Перед использованием

Поддерживаемые файлы изображений
Обработке в PHOTOfunSTUDIO могут подвергаться файлы изображений в следующих форматах.

	Неподвижное изображение
Формат JPEG Расширения: 

.JPG, .JPEG, .JPE
JPEG является аббревиатурой Joint Photographic Experts Group, это имя происходит из названия комитета, 
разработавшего этот формат сжатия. Этот формат файла перенимает метод сжатия данных, который сокращает 
цветовые данные цветного изображения до предела, за которым человеческое зрение не сможет его различить.

Формат BMP Расширения: 
.BMP

BMP является аббревиатурой Bitmap, и представляет собой формат изображения, наиболее используемый в Windows®.
●●Исключены некоторые файлы BMP в специальных форматах.

Формат TIFF Расширения: 
.TIF, .TIFF

TIFF является аббревиатурой Tagged Image File Format (теговый формат файлов изображений).
Несмотря на то, что данные сжимаются, их можно восстановить после сохранения (сжатие без потери 
данных). Это означает, что качество изображения не ухудшается даже при повторном сохранении данных.

Формат RAW Расширения: 
.RAW, .RW2

Это необработанные данные изображения, которые были записаны с помощью цифровой 
камеры и не были преобразованы.
Если данные изображения JPEG для миниатюр содержатся в файле RAW, миниатюра отображается в Списковом режиме. 
Файлы RAW, не содержащие информации о миниатюре, будут отображаться как [RAW], и являются несовместимыми.

	Движущееся изображение
Формат Motion JPEG 
(Движущееся 
изображение MOV)

Расширения: 
.MOV

Файлы движущегося изображения QuickTime 
являются целевыми файлами. 
(Движущиеся изображения QuickTime VR, 
которые созданы с помощью совмещения 
панорамных изображений, воспроизводятся с 
использованием QuickTime Player.)  

●●Файлы с расширением CONT являются файлами 
управления, автоматически создаваемыми при 
копировании на ПК.
(Действительные данные движущегося 
изображения AVCHD/AVCHD Lite 
сохраняются в виде файла формата m2ts.)
●●Не удаляйте, не изменяйте и не 
перемещайте файлы или папки, используя 
Explorer и т.п.  Это  может привести к 
невозможности воспроизведения или 
редактирования.

Формат AVCHD
(Движущееся 
изображение AVCHD/
AVCHD Lite)

Расширения: 
.CONT
(m2ts)

Представляет собой движущееся изображение, 
записанное на базе стандарта AVCHD (высокая 
четкость).

Формат MPEG2 
(Движущиеся 
изображения MPEG2)

Расширения:
.MPG

MPEG2 представляет собой формат 
движущихся изображений, широко 
используемый для видео DVD и т.п.

Важно
●●Предусмотрено использование снимков, записанных с помощью этого ПО или с помощью цифровой камеры, которая совместима с данным ПО. 
(Тем не менее, движущиеся изображения в формате DVD-Video являются несовместимыми.) Снимки, записанные с помощью другой цифровой 
камеры или другого программного обеспечения, могут отображаться неправильно, или работа с ними может проходить ненормально.
●●Правильная работа возможна только для изображений с датой записи между 1971 и 2037 г. г.
●●Файлы, не удовлетворяющие описанному выше условию, являются несовместимыми и отображаться не будут.
●●Если изображение имеет очень большой размер или записано в специальном формате, оно может не отображаться.
●●При работе с совместимыми файлами имеются некоторые ограничения в категоризации, обработке, корректировании, выводе, 
редактировании движущегося изображения / функции вывода и пр. Пожалуйста, ознакомьтесь с пояснениями по каждой функции.
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Перед использованием

Рабочая среда
Ниже описана рабочая среда ПК, необходимая для использования этого программного обеспечения.

Персональный 
компьютер

Для Windows® 7: IBM® PC/AT-совместимый персональный компьютер, имеющий ЦПУ Intel® Pentium® III 1ГГц или более 
быстрый (включая совместимые процессоры) 
Для Windows Vista®: �IBM® PC/AT-совместимый ПК, имеющий процессор Intel® Pentium® III 800 МГц и выше (включая 

совместимые процессоры)
Для Windows® XP: �IBM® PC/AT-совместимый ПК, имеющий процессор Intel® Pentium® III 500 МГц и выше (включая 

совместимые процессоры)
Рекомендуемая среда для функции движущегося изображения AVCHD/AVCHD Lite 

Для воспроизведения движущихся изображений: �Intel® Core™ 2 Duo 2,16 ГГц/Pentium® D 3,2 ГГц и выше 
Для редактирования движущихся изображений: Intel® Core™ 2 Quad 2,6 ГГц и выше 
Минимальные требования к среде для функции движущегося изображения AVCHD/AVCHD Lite (среда, в 
которой возможно воспроизведение со скоростью 2 кадра/секунду):
Intel® Pentium® III 1 ГГц и выше

ОС Прединсталлированная
Microsoft® Windows® 7 (32 бит) Starter
Microsoft® Windows® 7 (32 бит/64 бит) Home Basic
Microsoft® Windows® 7 (32 бит/64 бит) Home Premium
Microsoft® Windows® 7 (32 бит/64 бит) Professional
Microsoft® Windows® 7 (32 бит/64 бит) Ultimate
Microsoft® Windows Vista® (32 бит) Home Basic или Service Pack 1/Service Pack 2
Microsoft® Windows Vista® (32 бит) Home Premium или Service Pack 1/Service Pack 2
Microsoft® Windows Vista® (32 бит) Business или Service Pack 1/Service Pack 2
Microsoft® Windows Vista® (32 бит) Ultimate или Service Pack 1/Service Pack 2
Microsoft® Windows® XP (32 бит) Home Edition Service Pack 2/Service Pack 3
Microsoft® Windows® XP (32 бит) Professional Service Pack 2/Service Pack 3

Оперативная 
память

Для Windows® 7: 1 ГБ или больше
Для Windows Vista®: 512 Мб или больше
Для Windows® XP: 512 Мб или больше
Для функции движущихся изображений AVCHD/AVCHD Lite: 1 Гб или более

Монитор Высококачественное цветовоспроизведение (16 битов) и более (рекомендуется 32 бита и более)
Разрешение экрана 1024×768 пикселей или больше (1280×1024 пикселей или больше рекомендуется)
Видеокарта
Для Windows® 7: Графическая плата, подходящая для DirectX® 10
Для Windows Vista®: Графическая плата, подходящая для DirectX® 10
Для Windows® XP: Графическая плата, подходящая для DirectX® 9.0c
Поддержка оверлея DirectDraw®

Рекомендуется PCI Express™ x16 
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Перед использованием

Рабочая среда

Свободное место 
на жестком диске

Ultra DMA-100 и выше
450 Mб и более для установки ПО

●●При записи на DVD потребуется в два раза больше свободного пространства диска.
●●Если настройка сжатия включена, во время записи возникнут ошибки. Снимите флажок с [Compress this drive to save 
disk space] в [Properties] для жесткого диска.

Необходимое 
программное 
обеспечение

Для Windows® 7
DirectX® 10

Для Windows Vista®

DirectX® 10
Для Windows® XP

DirectX® 9.0c
●●При установке в ПК программного обеспечения, не совместимого с DirectX® 9.0c, может нарушиться правильная 
работа ПК. Информацию о совместимости своего ПК вы можете получить у производителя.

.NET framework 2.0
SQL Server Compact 3.5
Internet Explorer® 6.0 и более поздние версии
QuickTime Player 7.6.5 и более поздние версии

Звук Звуковое устройство, совместимое с Windows
Дисковод CD-ROM (необходим для установки данной программы)

●●Для записи DVD требуется совместимый привод и носитель.
Интерфейс USB-порт (Hi-Speed USB (USB2.0))
Прочие 
требования

Мышь или равноценное указательное устройство 
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Перед использованием

Рабочая среда

●●Даже если все системные требования, указанные в данном 
руководстве пользователя, выполнены, некоторые ПК не смогут 
быть использованы.
●●Работа данного ПО не гарантируется при выборе и 
использовании шрифтов, отличных от английских.
●●Данное ПО может не работать корректно на ПК, собранных 
пользователем.
●●Это программное обеспечение невозможно использовать на ОС 
Microsoft Windows® 3.1, Windows® 95, Windows® 98, Windows® 
98SE, Windows® Me, Windows NT® и Windows® 2000.
●●Функционирование не гарантируется на Microsoft® Windows Vista® 
Enterprise, Windows® 7 Enterprise, Windows® XP Media Center 
Edition, Tablet PC Edition. 
●●Функционирование не гарантируется на 64-битных версиях 
Windows® XP и Windows Vista®.
●●Функционирование в режиме XP на Windows® 7 не гарантируется.
●●Работа в прошедших обновление ОС не гарантируется.
●●Мультизагрузочные оболочки не поддерживаются.
●●Данное ПО не поддерживает среды с несколькими мониторами.
●●Только системный администратор может устанавливать или 
удалять это программное обеспечение.
●●Перед началом использования войдите в программу через счет 
администратора или стандартный счет пользователя. Вы не 
можете использовать данное программное обеспечение через 
гостевой счет.

●●Когда работает программа PHOTOfunSTUDIO, невозможно 
использовать функции энергосбережения, например, хранители 
экрана Windows, дисплей состояния сна или автоматический 
дисплей.
●●Если параметры для размера знаков в диалоговом окне 
настройки экрана в Windows превышают стандартный размер, 
то некоторые кнопки отобразятся вне экрана без возможности их 
использования. В таком случае обновите размер знаков, приведя 
их к стандарту.
●●При подключению к ПК 2 или более устройств USB, а также 
при подключении устройств через USB концентраторы или с 
помощью удлинителей, надлежащая работа не гарантируется.
●●Функционирование на Windows Vista®/Windows® 7 Ultimate с 
пользовательским интерфейсом, установленным на другие 
языки с помощью функции Multi-language User Interface (MUI), не 
гарантируется.
●●Работа предусмотрена только с теми движущимися 
изображениями AVCHD/AVCHD Lite, которые были созданы с 
помощью следующих средств.
- данного ПО
- �Цифровая камера, с которой поставляется это программное 

обеспечение
●●Для карты памяти SDHC (от 4 ГБ до 32 ГБ) или карты 
памяти SDXC (от 48 ГБ до 2 ТБ) потребуется устройство, 
поддерживающее соответствующую карту памяти.
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Установка

Подсоединение цифровой камеры к ПК
При подсоединении цифровой камеры, совместимой с данным ПО, обеспечивается перенос снимка с карты памяти камеры. Возможна 
также запись снимка на карту памяти с ПК.

Важно
Убедитесь в том, что батареи цифровой камеры и ноутбука 
достаточно заряжены. Воспользуйтесь адаптером переменного 
тока, если это возможно.

1 Запустите ПК.

2 Включите цифровую камеру.

3 Подсоедините цифровую камеру к ПК.
Подсоедините, полностью вставив соединительный кабель 
USB, поставляемый с цифровой камерой.

4 Установите цифровую камеру на 
соединение с ПК.
Когда цифровая камера будет распознана на ПК, 
отобразится окно [Copy to PC].
Для копирования изображений на ПК, следуйте 
инструкции. (→19)

Советы
●●За дальнейшей информацией относительно подсоединения 
обращайтесь к инструкции по эксплуатации для цифровой 
камеры.
●●Когда цифровая камера правильно распознается на ПК, она 
добавляется на [Computer] ([My Computer]) в качестве привода.
●●Если отображается окно, отличное от PHOTOfunSTUDIO, 
например, окно LUMIX Simple Viewer, щелкните [No], чтобы 
закрыть окно.
●●Если экран [Copy to PC] не отображается, выберите иконку 
PHOTOfunSTUDIO в окне автоматического просмотра Windows 
(окне выбора операции).
●●Не работайте с цифровой камерой и не отсоединяйте кабель 
соединения USB во время переноса данных на цифровую камеру. 
ПО может сработать некорректно и повредить переносимые 
данные.
●●На некоторые цифровые камеры невозможно копировать снимки 
с этого программного обеспечения. В таких случаях, пожалуйста, 
воспользуйтесь устройством для считывания/записи карт памяти 
SD и т.п.
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Установка

Подсоедините цифровую камеру к ПК

Удаление цифровой камеры с ПК

Пример панели задач

1 Проверьте, что цифровая камера 
не обращается к ПК, например, не 
выполняется операция записи.

2 Дважды щелкните  или  на 
панели задач ПК.

3 Выберите [USB Mass Storage Device] и 
щелкните [Stop].
Если отображается несколько устройств USB, Вы можете 
дважды щелкнуть по каждому из них, чтобы проверить, 
какое из них является цифровой камерой.

4 Удалите соединительный кабель USB 
от ПК.

5 Выключите цифровую камеру.
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Установка

Запуск PHOTOfunSTUDIO
Важно
Перед первым использованием обязательно выберите [Start] → 
[All Programs] → [Panasonic] → [PHOTOfunSTUDIO 5.2 HD Edition] 
→ [Readme] и прочитайте дополнительные объяснения и самую 
последнюю информацию.

1 Дважды щелкните по  на рабочем 
столе.
В меню Start выберите [All Programs] → [Panasonic] → 
[PHOTOfunSTUDIO 5.2 HD Edition].

Советы
●●Проверка обновлений приложения при загрузке (→131)
●●В среде без соединения с Интернетом для запуска приложения 
PHOTOfunSTUDIO может потребоваться некоторое время.
●●При первом запуске программного обеспечения для отображения 
окна может потребоваться некоторое время, так как сначала 
выполняется анализ изображений, сохраненных на ПК.
●●Когда к ПК подсоединена цифровая камера или установлена 
карта памяти, PHOTOfunSTUDIO запускается автоматически и 
отображается экран [Copy to PC]. (→19)

Для выхода

1 Щелкните  в окне.
Вы также можете выйти, выбрав [File] → [Exit] из меню.

2 При отображении подтверждающего 
сообщения щелкните [OK].
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Сохранение снимков
Копирование снимков с цифровой камеры или карты памяти на ПК
Важно
Не работайте с цифровой камерой и не отсоединяйте 
соединительный кабель USB во время переноса данных.

1 Подсоедините устройство, например, 
цифровую камеру или устройство для 
считывания карт памяти.

2 Щелкните [Yes].
Отображается экран [Copy to PC].

●●Если вложенное окно не отображается, щелкните  [Copy 
to PC]. 
●●Вы можете также отобразить экран, выбрав [File] → [Copy to 
PC] из меню.
●●Если отображается окно автоматического просмотра 
Windows (окно выбора операции), щелкните , чтобы 
закрыть окно.

3 Если отображается окно выбора 
места, с которого будет выполняться 
копирование, выберите накопитель и 
щелкните [Next].

●●Если подсоединенный накопитель или карта памяти не 
отображаются, щелкните [Refresh].

4 Выберите снимки для копирования на ПК.
При выборе квадратика в верхнем левом углу снимка 
снимок будет скопирован на ПК.

●●Щелкните по снимку, чтобы выбрать его или отменить выбор.
●●Щелкните [Select all] для выбора всех снимков.
●●Щелкните [Deselect all] для отмены выбора всех снимков.

5 Щелкните [Next].
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Копирование снимков с цифровой камеры или карты памяти на ПК
Сохранение снимков

Советы
●●Невозможно использовать следующие однобайтовые символы в 
качестве ключевого слова. 
\ ? / “ ; : , < > ! * | ’ ^ [ ] % _

6 Выберите папку назначения для копирования.
	Для сохранения в папке, которая не показана

1 Щелкните [Browse save destination folders].
2 Выберите папку и щелкните [OK].

●●Чтобы создать новую папку для сохранения, щелкните по 
[Make New Folder], введите название папки и щелкните [OK].

7 Выберите вложенную папку, в которую 
будут сортироваться снимки.
[Day of acquisition]	: �Сохраните в папке с сегодняшней 

датой. (Пример: 20100701)
[Recording month]		: �Сохраните в папке для месяца 

записи. (Пример: 201006)
[Recording day]					: �Сохраните в папке для даты записи. 

(Пример: 20100630)
[Specified folder]				: �Сохраните в папке, созданной Вами. 

(Пример: Свадебная церемония)

8 Введите ключевое слово.
(Можно использовать до 32 символов (однобитных).)
Введенные ключевые слова можно использовать для 
классифицированного отображения.
Если Вы не хотите устанавливать ключевое слово, 
перейдите к шагу 9.

9 Щелкните [Execute].

10 При отображении подтверждающего 
сообщения щелкните [Yes].
Снимки сортируются и копируются в установленные папки.



21

Копирование снимков с цифровой камеры или карты памяти на ПК
Сохранение снимков

Советы
●●Возможно копирование снимков с карты памяти, если они 
записаны с помощью этого программного обеспечения или 
на цифровой камере, поддерживающей это программное 
обеспечение, и движущихся изображений на DVD, если они 
записаны в формате AVCHD.
При обработке в данном программном обеспечении возможны 
проблемы с копированием, выводом и воспроизведением 
снимков, записанных на других цифровых камерах или с 
использованием другого программного обеспечения.
●●Правильная работа возможна только для изображений с датой 
записи между 1971 и 2037 г. г.
●●Не удаляйте, не изменяйте и не перемещайте файлы (с 
расширениями .cont/.m2ts/.tmb/.iis и пр.) или папки, имеющие 
отношение к движущимся изображениям AVCHD/AVCHD Lite, 
используя Explorer или подробным способом. Это может привести 
к невозможности воспроизведения или редактирования.
(Файлы, относящиеся к движущимся изображениям AVCHD/
AVCHD Lite, создаются в том же самом месте, что и 
скопированный файл.)
●●Изображения, записанные в режиме серии, копируются во 
вложенные папки, которые создаются для каждой группы.

11 При отображении подтверждающего 
сообщения о завершении копирования 
щелкните [OK].

12 При отображении после копирования 
окна завершения щелкните [Close].

	О папках для сохранения
Следующие назначения для копирования устанавливаются 
по умолчанию.

●●Documents (My Documents)
●●Pictures (для Windows 7 или Windows Vista)
●●Desktop 

Когда ОС Windows установлена на накопителе C, места 
папок приведены ниже.
Для Windows 7 или Windows Vista
Documents

C:\Users\(Имя пользователя)\Documents
Pictures

C:\Users\(Имя пользователя)\Pictures
Desktop

C:\Users\(Имя пользователя)\Desktop
Для Windows XP
My Documents

C:\Documents and Settings\(Имя пользователя)\My Documents
Desktop

C:\Documents and Settings\(Имя пользователя)\Desktop
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Вы можете выбирать 
или отменять выбор 
всех отображаемых 
снимков.

Информационное поле
Показаны данные, например, 
информация об изображении, 
выбранном в поле показа, 
и состояние выполняемой в 
настоящее время функции.

Об основном окне

Основные операции

Панель меню
Различные функции 
организованы по пунктам.

Панель инструментов
Кнопки предназначены для 
часто используемых функций.
Меню отображается при щелчке 
по некоторым из этих кнопок.

Поле показа папки
Поле показа календаря
Поле показа названия места

Пункты папки, календаря или 
названий мест показаны в виде 
списка. Изображения в папке, 
дата записи или место записи, 
выбранные здесь, отображаются в 
поле показа справа.
Количество изображений показано 
справа от папки, даты или 
названия места.

Поле ограниченной настройки
Вы можете устанавливать 
ограниченные условия по 
распознаванию лиц или по пункту 
классификации для снимков, 
которые нужно показать.

Вы можете группировать вместе 
неподвижные изображения, 
которые были записаны в режиме 
серии, или развертывать их.

Вы можете изменить порядок 
списка снимков в поле просмотра 
и указать формат данных для 
изображений, которые нужно 
показать.

 : Все
 : �Только неподвижные 

изображения
 : �Только движущиеся 

изображения

Вы можете поворачивать 
выбранное неподвижное 
изображение на 90 градусов.

Вы можете увеличивать или 
уменьшать снимки в поле показа.
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Об основном окне
Основные операции

Поле показа
Снимки, соответствующие пункту папки или календаря, 
указанному слева, и условиям в поле узкой установки, 
отображаются в виде списка.

●●Несовместимые файлы не отображаются.
●●Описание иконки

		 : Неподвижное изображение
		 : �Неподвижное изображение в формате RAW 
		 : �Движущееся изображение MOV 
		 : �Движущееся изображение AVCHD/AVCHD Lite 
		 : �Движущиеся изображения AVCHD/AVCHD Lite, 

отредактированные с помощью этого программного 
обеспечения

		 : �Движущиеся изображения MPEG2
		 : �Панорамные изображения
		 : �Изображения, для которых избранные установлены 

с помощью поддерживаемой цифровой камеры или 
данного программного обеспечения.

		 : �Защищенные снимки (только для чтения)
		 : �Информация, например, заголовок или название
		 : �Изображения, имеющие информацию GPS
		 : �Неподвижные изображения, записанные в режиме 

серии
		 : �Движущиеся изображения MOV, записанные в 

высокоскоростном видео режиме
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Основные операции

Переключение между стилями отображения окон
Показ снимков в папке в окне списка (окно миниатюр)

Могут отображаться только изображения в зарегистрированной папке.

Советы
●●Простое воспроизведение выполняется при наведении указателя 
мыши на миниатюру движущегося изображения. Для изменения 
установки (→129)
●●Для установки дополнений или регистрации и т.п. 
зарегистрированных папок (→27)

1 Щелкните  [Folder].
Стиль отображения окна переключился.

●●Вы также можете переключить, выбрав [View] → [Display 
mode] → [Thumbnail display] из меню.

2 Щелкните по папке, которую Вы 
хотите посмотреть.
Изображения в папке отображаются в виде списка.

●●Щелкните по  или дважды щелкните по имени папки, 
чтобы показать или скрыть вложенные папки.
●●Дважды щелкните по снимку для показа окна просмотра. 
(Если такие неподвижные изображения записаны в 
режиме серии и отображаются в виде группы, то они будут 
развернуты для показа миниатюр.)

	Изменение порядка изображений
1 Выберите пункт, по которому будут сортироваться 

данные ( A ).
[Name]: Показ в порядке имен.
[Date of recording]: Показ в порядке даты записи.
[File size]: Показ в порядке размера файла.

●●Щелкните еще раз для переключения с порядка по 
возрастанию (▲) на порядок по убыванию (▼).
●●Вы также можете изменить порядок, выбрав [View] → 
[Sorting pictures] из меню.

A
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Основные операции

Переключение между стилями отображения окон

Показ снимков с одинаковой датой записи (календарное отображение)

1 Щелкните  [Calendar].
Стиль отображения окна переключился.

●●Вы также можете переключить, выбрав [View] → [Display 
mode] → [Calendar display] из меню.

2 Щелкните по отображаемому году, 
месяцу и дню.
Отображение переключается на отображение выбранного 
года, месяца или дня.

●●Годы, месяцы и дни, для которых нет записанных снимков, 
не отображаются.
●●Щелкните по  или дважды щелкните по году или месяцу, 
чтобы показать или скрыть месяцы или дни.
●●Отображение по году

Дважды щелкните по месяцу, для 
которого показан снимок, чтобы 
переключить на отображение с 
разбивкой по месяцам.

●●Отображение по месяцу
Дважды щелкните по дню, для которого 
показан снимок, чтобы переключить на 
отображение с разбивкой по дням.

●●Отображение по дате записи
Дважды щелкните по снимку для показа 
окна просмотра.
(Если такие неподвижные изображения 
записаны в режиме серии и отображаются 
в виде группы, то они будут развернуты 
для показа миниатюр.)

Советы
●●Дата и время обновления отображаются для снимков, которые не 
имеют информации о дате и времени записи.
●●Для календарного отображения (отображения по году или 
месяцу) наведите указатель мыши на месяц или день, для 
которого отображается миниатюра, чтобы отобразить по порядку 
снимки, записанные в этот месяц или день.
●●Для установки дополнений или регистрации и т.п. 
зарегистрированных папок (→27)
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Основные операции

Переключение между стилями отображения окон

Показ изображений по месту записи (отображение по месту записи)

1Щелкните  [Place-name].
Стиль отображения окна переключился.

●●Вы также можете переключить, выбрав [View] → [Display 
mode] → [Place-name display] из меню.

2Щелкните по отображаемому месту 
записи.
Показаны изображения, записанные для выбранного 
названия места.

●●Названия мест, для которых нет записанных изображений, 
не показаны.
●●Щелкните  или дважды щелкните по названию места, 
чтобы показать или скрыть подробности названия места.
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Основные операции

Переключение между стилями отображения окон

1 Выберите [Tools] → [Settings] из меню.
2 Щелкните [General] — [Registration folder].

A : Зарегистрированные в настоящее время папки
3 Щелкните [Add].
4 Выберите папку для регистрации и щелкните [OK].

5 Щелкните [Apply].
●●При выполнении щелчка по [OK] применяются установки, и 
окно закрывается.
●●Выберите папку и щелкните [Delete] ( B ), чтобы удалить 
папку регистрации. 

	�Отображение файлов изображений или вложенных 
папок
Согласно установке по умолчанию отобразятся все файлы.

●●Если Вы не хотите отображать изображения всех вложенных 
папок, удалите метку от [Display all picture files from the folder]  
( C ).

Советы
●●При добавлении папки для показа окна может потребоваться 
некоторое время, поскольку сначала выполняется анализ 
информации категорий изображений и других данных.
●●Даже если Вы удалите папку регистрации, папки, которые 
сохранены на ПК, и снимки в этих папках не удаляются.
●●Можно добавить максимум 30 папок регистрации.
●●Съемные диски и сетевые папки не могут быть 
зарегистрированы.

Добавление папок регистрации
Добавление или регистрация отображаемых папок.

A

B

C
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Основные операции

Выбор снимков

1 Щелкните по изображениям в поле 
показа. 
Снимок, по которому Вы щелкнули мышью, заключается в 
рамку и выбирается.

●●Чтобы выбрать два или больше снимков 
Щелкните по снимкам, удерживая нажатой клавишу [Ctrl].
●●Чтобы выбрать два или больше последовательных снимков 
Выберите первый снимок, а затем, удерживая клавишу 
[Shift] в нажатом положении, выберите последний снимок.
●●Чтобы выбрать все показанные снимки
- Щелкните [Select all] ( A ).
- �Щелкните левой клавишей мыши по полю показа, затем 

удерживайте клавишу [Ctrl], пока Вы будете нажимать 
клавишу [A].

●●Чтобы снять выделение со снимков
- Щелкните [Deselect all] ( B ).
- Щелкните по месту, отличному от снимка, в поле показа.

Советы
●●Невозможно выбирать снимки на календарном отображении 
(отображении по году или месяцу).
●●Миниатюры будут воспроизводиться с индикацией [Error] 
вследствие любой из возможных причин ниже:
- �Папки или файлы изображений были перемещены или удалены 

с помощью другого программного обеспечения после того, как 
папки были зарегистрированы или файлы изображений были 
скопированы с помощью этого программного обеспечения.

- �Папка регистрации, созданная с помощью этого программного 
обеспечения, не существует. 
Для получения дополнительной информации обратитесь к 
пункту “Показ” в разделе “Проблемы и их решения (В&O)” (→137)

Выберите изображения для отображения, копирования, перемещения или редактирования и т.п.
Дополнительно к выбору изображений щелчком по миниатюре Вы также можете выбирать их, добавляя метку в окне выбора снимка 
каждой функции.

	Выбор
Щелкните по снимку для добавления рамки 
вокруг него.

	Метка
Щелкните по снимку для добавления метки. 

Для выбора снимков

A
B
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Основные операции

Выбор снимков

Добавление меток к снимкам
При выборе целевых снимков на экране для выполняемой функции, например, копировании на ПК или редактировании изображения, 
щелкните по снимку для добавления метки.

1 Щелкните по снимку.
Добавляется метка, и выбирается снимок.
Когда Вы закроете эту функцию и вернетесь в главное 
окно, метки будут удалены. 

●●Вы можете добавлять метки к нескольким снимкам.
●●Для добавления меток ко всем отображаемым снимкам
- Щелкните [Select all] ( A ).
- �Щелкните левой клавишей мыши по полю показа, затем 

удерживайте клавишу [Ctrl], пока Вы будете нажимать 
клавишу [A].

●●Для удаления метки
Щелкните по снимку, на котором есть метка.
●●Для удаления всех меток
Щелкните [Deselect all] ( B ).
●●Если отображение группы установлено для неподвижных 
изображений, записанных в режиме серии, метки 
отображаются в следующем виде.

 : �Галочки не добавляются ни к каким неподвижным 
изображениям

 : �Галочки добавляются к некоторым неподвижным 
изображениям

 : �Галочки добавляются ко всем неподвижным 
изображениям

●●При щелчке по изображению с состоянием  все 
изображения в серийной группе изменяют состояние на 
выбранное .
При повторном щелчке по изображению все изображения в 
серийной группе изменяют состояние на отмененное .

Советы
●●При помощи меток Вы можете одновременно выбрать несколько 
снимков в разных папках.

A B
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Основные операции

Копирование/перемещение снимков

Советы
●●Для копирования или перемещения изображений можно также 
использовать клавиатуру. ([Ctrl]+C = копировать, [Ctrl]+V = 
вставить, [Ctrl]+X = переместить)
●●Вы также можете копировать или перемещать изображения, 
выбрав изображения и используя меню по правому щелчку 
мыши. (→35)
●●Папки можно перемещать, перетащив и оставив папки в другую 
папку. (Для копирования удерживайте [Ctrl] во время операции 
перетаскивания.)
●●С помощью этой операции невозможно копировать движущиеся 
изображения AVCHD/AVCHD Lite на карту памяти или DVD. 
Используйте [Copy to PC].
●●При копировании на карту памяти, CD или DVD используйте 
[Copy to media].
●●Если результат операции не отображен, обновите окно. 
●●Если неподвижные изображения, записанные в режиме серии, 
копируются в ту же самую папку с другими именами, то они 
рассматриваются, как находящиеся в одной и той же серийной 
группе.

1 Щелкните  [Folder].

2 Выберите снимок, который Вы хотите 
скопировать или переместить.

●●Вы можете выбрать несколько снимков.

3 Перетащите и отпустите снимок в 
папку назначения.

●●Для копирования перетащите и отпустите, удерживая 
нажатой клавишу [Ctrl].

4 При отображении подтверждающего 
сообщения щелкните [Yes].
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Основные операции

Удаление снимков

Советы
●●Для удаления изображений, записанных на карту памяти, 
удаляйте их с помощью цифровой камеры. (Более подробные 
сведения см. в инструкции для цифровой камеры.)
●●Не используйте Explorer или подобный способ для удаления 
любых файлов или папок, относящихся к движущимся 
изображениям AVCHD/AVCHD Lite, которые были скопированы на 
ПК. Это может привести к невозможности воспроизведения или 
редактирования.
●●Когда отображаются все неподвижные изображения и 
движущиеся изображения, выберите вложенную папку, а затем 
выберите опцию [Delete Folder] из меню с вызовом правым 
щелчком, чтобы удалить выбранную папку и все содержащиеся в 
ней изображения. 
Используйте Explorer для удаления папок, в которых находится 
содержание, удалить которое с помощью этого программного 
обеспечения невозможно, например, несовместимые файлы.

1 Выберите снимок, который Вы хотите 
удалить.

●●Вы можете выбрать несколько снимков.

2 Выберите [File] → [Delete] из меню.
●●Вы также можете удалить, нажав клавишу [Delete].

3 При отображении подтверждающего 
сообщения щелкните [Yes].
Снимок удаляется.

Вы можете удалить снимки, сохраненные на ПК.
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Основные операции

Защита изображений
Вы можете установить защиту против случайного удаления. При установленной защите снимки предназначены только для чтения, и 
их невозможно удалить.

1 Выберите снимок, который Вы хотите 
защитить.

2 Выберите [File] → [Protect] → [ON] из 
меню.

●●При выбранной опции [OFF] защита изображений 
отменяется.

3 При отображении подтверждающего 
сообщения щелкните [Yes].
Снимок защищен.

Советы
●●Для изображений с установленной защитой отображается 
значок , и их невозможно удалять или перезаписывать с 
отредактированными данными. Для удаления или перезаписи 
изображения сначала измените установку на отмену защиты, 
чтобы снять защиту.
●●  Изображения, для которых опция [ЗАЩИТИТЬ] установлена 
на поддерживаемой цифровой камере, при копировании на ПК 
меняют установку на установленную защиту
●●Снимки, для которых установлена опция установки защиты, также 
сохраняют свои установки защиты при копировании на носитель. 
(Кроме движущихся изображений AVCHD/AVCHD Lite)
●●Если защита устанавливается для неподвижного изображения, 
записанного в режиме серии, во время отображения группы, 
установка защиты применяется ко всем неподвижным 
изображениям в группе. Если Вы хотите установить защиту только 
для некоторых неподвижных изображений, разверните серийную 
группу и установите каждое изображение по отдельности.

Защищенное изображение
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Основные операции

Обновление окна

Советы
●●Если окно не обновляется по результатам операций с файлами 
или папками, которые Вы выполняли с помощью другого 
программного обеспечения, обновите окно.

1 Выберите [View] → [Refresh] из меню.
Окно обновляется.

Если окно не обновляется по результатам выполнения операций, например, редактирования снимков, обновите окно вручную.
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Основные операции

Установка в качестве избранного
Если Вы установите изображение в качестве избранного, на изображении отобразится значок , также как и для изображений, для 
которых установлена опция [ИЗБРАННОЕ] на поддерживаемых цифровых камерах. 

Изображение, установленное как 
избранное

1 Выберите изображение, которые Вы 
хотите установить как избранное.

2 Выберите [File] → [Favorite] →[ON] из 
меню. 

●●Выберите опцию [OFF] для удаления установки избранного.

3 При отображении подтверждающего 
сообщения щелкните [Yes].

●●Изображение будет установлено как избранное.

Советы
●●Изображения, для которых опция [ИЗБРАННОЕ] установлена 
на поддерживаемой цифровой камере, при копировании на ПК 
меняют свою установку на установленное избранное.
●●Изображения, для которых установлена опция избранного, 
также сохраняют свои установки избранного при копировании на 
носитель. (Кроме движущихся изображений AVCHD/AVCHD Lite)
●●Если избранное устанавливается для неподвижного 
изображения, записанного в режиме серии, во время 
отображения группы, установка избранного применяется ко всем 
неподвижным изображениям в группе. Если Вы хотите установить 
избранное только для некоторых неподвижных изображений, 
разверните серийную группу и установите каждое изображение 
по отдельности.
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Основные операции

Использование меню с вызовом правым щелчком
При выборе и выполнении правого щелчка мышью по снимку или папке появляются некоторые функции.

Советы
●●Отображаемое меню зависит от состояния снимка или папки.
●●При изменении имени невозможно использовать следующие 
однобайтные символы. 
\ ? / “ : < > ! * | ’ _

1 Выберите снимок.

2 Щелкните по снимку правой клавишей 
мыши.
Отображается меню с вызовом правым щелчком.

3 Выберите функцию.
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Отображение окна просмотра

Просмотр снимков

Вы можете отобразить снимки, сохраненные на ПК.

Советы
●●При воспроизведении движущихся изображений, изображение и/или 
голос могут прерываться в зависимости от эффективности Вашего ПК.
●●В зависимости от среды ПК, функции [Windows Aero] в Windows 
или воспроизводящихся движущихся изображений во время 
воспроизведения может иметь место пропадание кадров или цветов, 
или же движущееся изображение может воспроизводиться неплавно.
Это может происходить чаще во время полноэкранного 
воспроизведения.
●●Частота кадров для воспроизведения движущихся изображений 
AVCHD/AVCHD Lite с помощью ЦПУ ПК. (нормативные значения)

Процессор Частота кадров (кадр/сек)
Pentium III 1,0 ГГц и больше 2
Pentium 4 Hyper-Threading Technology 
3,0 ГГц и больше 

8 (NTSC: 10)

Pentium D 3,0 ГГц и больше 25 (NTSC: 30)
Pentium D 3,2 ГГц, Core 2 Duo 2,16 ГГц и 
больше

50 (полей) 
(NTSC: 60)

Однако в зависимости от рабочей среды ПК частота кадров может 
быть меньше нормативной.

1 Щелкните по папке, в которой 
находятся снимки, которые Вы хотите 
просмотреть.
Снимки в папке отображаются в уменьшенном виде.

●●При использовании календарного отображения установите 
календарное отображение по дате записи.

2 Выберите снимок, который Вы хотите 
посмотреть, и дважды щелкните по нему.
Отображается окно просмотра.

●●Неподвижные изображения, записанные в режиме серии, 
которые отображаются в виде группы, будут развернуты для 
показа миниатюр.

3 Вы можете увеличивать или уменьшать 
неподвижное изображение или 
воспроизводить движущееся изображение.
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Об окне просмотра
	Во время показа неподвижного изображения

Снимки в поле показа Операционная панель

: Показ предыдущего снимка.
: Показ следующего снимка.
: Поворот на 90 градусов против часовой стрелки.
: Поворот на 90 градусов по часовой стрелке.
: Выбор/отмена выбора установки избранного.
: Увеличение снимка.
: Уменьшение снимка.
: Показ с первоначальным размером.
: Показ для соответствия размеру окна.
: Полноэкранный показ.
: Закрытие окна просмотра.

Дата записи:	�Отображение даты записи снимки.
Размер изображения:Отображение размера изображения.
Снимки в поле показа:	�Снимки, которые отображаются в поле 

показа главного окна. 
Щелкните для переключения окна.

Советы
●●Когда неподвижные изображения сгруппированы в серийную 
группу, отображается только репрезентативное изображение.
●●Чтобы отобразить все изображения в серийной группе, перед 
воспроизведением разверните изображения в серийной группе 
или щелкните правой кнопкой мыши по миниатюре в окне 
просмотра, чтобы выбрать [BURST PLAY].
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Об окне просмотра
	Во время показа серийного воспроизведения

: Воспроизведение изображений в обратном направлении.
: Воспроизведение изображений в прямом направлении.
: Остановка воспроизведения снимков.
: Пауза. (Во время показа серийного воспроизведения)
: �Выполнение покадрового воспроизведения в обратном 

направлении.
: �Выполнение покадрового воспроизведения в прямом 

направлении.
: Выбор/отмена выбора установки избранного.
: Поворот на 90 градусов против часовой стрелки.
: Поворот на 90 градусов по часовой стрелке.

: Изменение скорости воспроизведения изображений.
: Полноэкранный показ.
: Закрытие окна просмотра.

Дата записи:	�Отображение даты записи снимки.
Позиция воспроизведения: �Показ текущего положения 

воспроизведения и количества 
изображений в серийной группе.

Снимки в поле показа: �Снимки, которые отображаются в поле 
показа главного окна. 
Щелкните для переключения окна.

Снимки в поле показа Операционная панель
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Отображение окна просмотра
Просмотр снимков

Об окне просмотра
	Во время воспроизведения движущегося изображения

: Показ предыдущего снимка.
: Показ следующего снимка.
: Пауза.
: Воспроизведение.
: Остановка.
: �Во время паузы выполняется покадровое воспроизведение 

в обратном направлении.
: �Во время паузы выполняется покадровое воспроизведение 

в прямом направлении.
: �Сохранение приостановленного окна в качестве неподвижного изображения.
: Выбор/отмена выбора установки избранного.
: Отключение звука при щелчке. (Когда звук выводится)
●●Не отображается во время воспроизведения высокоскоростного видео.
: Начало вывода звука при щелчке. (Когда звук отключен)
●●Не отображается во время воспроизведения высокоскоростного видео.

: Настройка громкости.
●●Не отображается во время воспроизведения высокоскоростного видео.
: Полноэкранный показ.
: �Показ с первоначальным размером. 

(Только в полноэкранном режиме)
: �Показ для соответствия размеру окна. 

(Только в полноэкранном режиме)
: Закрытие окна просмотра.

Регулятор: �Показ положения воспроизведения движущегося 
изображения. Перетащите влево или вправо для 
перемещения позиции воспроизведения.

Дата записи:	�Отображение даты записи снимки.
Позиция воспроизведения: �Показ текущего положения 

воспроизведения и длительности 
движущегося изображения.

Снимки в поле показа: �Снимки, которые отображаются в поле 
показа главного окна. 
Щелкните для переключения окна.

Снимки в поле показа

Регулятор

Операционная панель

Советы
●●Для некоторых сред ПК во время воспроизведения содержания, 
например, движущихся изображений AVCHD/AVCHD Lite 
или движущихся изображений MOV, записанных в режиме 
HD, возможно пропадание кадров или цвета, а также 
воспроизведение может быть не плавным.
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Отображение окна просмотра
Просмотр снимков

Об окне просмотра
	Во время воспроизведения высокоскоростного движущегося изображения

: Показ предыдущего снимка.
: Показ следующего снимка.
: �Воспроизведение изображений в обратном направлении.
: Пауза.
: Воспроизведение.
: Остановка.
: �Во время паузы выполняется покадровое воспроизведение 

в обратном направлении.
: �Во время паузы выполняется покадровое воспроизведение 

в прямом направлении.
: �Сохранение приостановленного окна в качестве 

неподвижного изображения.
: Выбор/отмена выбора установки избранного.

 :�Изменение скорости воспроизведения изображений.
: Полноэкранный показ.
: �Показ с первоначальным размером. 

(Только в полноэкранном режиме)
: �Показ для соответствия размеру окна. 

(Только в полноэкранном режиме)
: Закрытие окна просмотра.

Дата записи:	�Отображение даты записи снимки.
Позиция воспроизведения: �Показ текущего положения 

воспроизведения и длительности 
движущегося изображения.

Снимки в поле показа: �Снимки, которые отображаются в поле 
показа главного окна. 
Щелкните для переключения окна.

	О полноэкранном показе
Щелкните дважды по окну показа или щелкните по  для его отображения в полноэкранном виде.

●●Для возврата к первоначальному размеру дважды щелкните по экрану еще раз или щелкните .
●●Когда указатель мыши удаляется с операционной панели во время полноэкранного показа и в течение примерно 3 секунд не выполняется 
никаких операций, операционная панель исчезает. Переместите мышь для его повторного отображения.

Снимки в поле показа Операционная панель
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Отображаемая подробная информация о снимке

1 Выберите снимок, для которого 
Вы хотите удалить подробную 
информацию.

2 Выберите [File] → [Properties] из меню.
Отображается информационное окно снимка.

3 Проверьте информацию.
Пункт Описание

File 
information

Имя файла, размер файла, тип файла, 
местоположение файла и т.д.

Camera 
information

Название производителя используемой 
цифровой камеры, название модели, дата 
записи, выдержка, диафрагма и т.д.

Categorisation 
information

Информация о классификации, например, 
категория и отдельные названия

●●Для пунктов, для которых не имеется информации, 
используется символ, например, [-].
●●Отображаемые пункты различаются в зависимости от 
формата файла снимка.

	Чтобы ввести комментарий
Вы можете ввести любой текст по Вашему желанию и 
сохранить его вместе со снимком. (Можно использовать до 
128 (однобитных) символов)
1 Щелкните по [Comment].
2 Введите текст и щелкните по [Apply].
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Отображаемая подробная информация о снимке
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Советы
●●Информация камеры о файлах изображений, которые были 
записаны цифровой камерой, отличной от Panasonic, или 
которые были обработаны, может отображаться неправильно.
●●Вы можете добавлять комментарий только к изображениям, 
которые были скопированы на Ваш ПК. 
Невозможно добавлять комментарий к изображениям на карте 
памяти и т.п.
●●Вкладка информации названия места отображается только для 
изображений, которые имеют информацию GPS.
●●Измененная информация названия места доступна только в 
PHOTOfunSTUDIO.
●●Если отображение группы установлено для неподвижных 
изображений, записанных в режиме серии, изменения ввода 
комментария или информации названия места применяются ко 
всем неподвижным изображениям в группе.

	Для ввода информации о названии места
При щелчке по названию места Вы сможете изменить 
имя с помощью клавиатуры. (Кроме ориентиров: Можно 
использовать до 72 символов (однобайтных). Ориентиры: 
Можно использовать до 128 символов (однобайтных).)
1 Щелкните [Place-name information].
2 Введите название места или ориентир и щелкните 

[Apply].
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Воспроизведение слайд-шоу
Немедленный просмотр слайд-шоу

Вы можете осуществлять слайд-шоу снимков (неподвижных / движущихся изображений в любом формате, отличном от RAW) в поле 
показа и воспроизводить их.
Музыка и эффекты перехода соответствуют установкам. (→50)

1 Выберите папку или снимки.

2 Щелкните  [Slide show] и затем 
выберите [Playback now].
Начнется слайд-шоу.

: Пауза.
: Воспроизведение.
: Остановка.
: Отключение звука при щелчке. (Когда звук выводится)
: Начало вывода звука при щелчке. (Когда звук отключен)
: Изменение установки слайд-шоу. (→45)

: Настройка громкости.
: Выход из слайд-шоу.

Регулятор: �Показ положения воспроизведения слайд-
шоу. Перетащите влево или вправо для 
перемещения позиции воспроизведения.

Позиция воспроизведения: �Показ текущего положения 
воспроизведения и 
длительности слайд-шоу.

●●Когда указатель мыши удаляется с операционной панели 
и в течение примерно 3 секунд не выполняется никаких 
операций, операционная панель исчезает. Переместите 
мышь для его повторного отображения.

Советы
●●Невозможно выполнить операцию [Playback now] для слайд-шоу на 
календарном отображении с разбивкой по годам или по месяцам.
●●В случае отображения более 1 000 снимков они могут 
воспроизводиться неправильно.
●●Если отображение группы установлено для неподвижных 
изображений, записанных в режиме серии, неподвижным 
изображением, которое используется для воспроизведения слайд-шоу, 
обычно бывает первое неподвижное изображение в группе. Однако 
если некоторые неподвижные изображения были установлены как 
избранные, то выбирается неподвижное изображение, установленное 
как избранное, которое ближе всего к первому изображению.
●●Для некоторых сред ПК во время воспроизведения содержания, 
например, движущихся изображений AVCHD/AVCHD Lite 
или движущихся изображений MOV, записанных в режиме 
HD, возможно пропадание кадров или цвета, а также 
воспроизведение может быть не плавным.

Операционная панель
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Выбор изображений для создания слайд-шоу
Вы можете создать слайд-шоу, к которому можно добавить предпочитаемые Вами музыку или эффекты перехода для снимков 
(неподвижных движущихся изображений в любом формате, отличном от RAW) в поле показа.
Вы можете сохранить созданные Вами слайд-шоу и воспроизводить их в любое время по Вашему желанию.

Советы
●●В случае создания слайд-шоу из более чем 1 000 неподвижных 
изображений оно может воспроизводиться неправильно.
●●Если отображение группы установлено для неподвижных 
изображений, записанных в режиме серии, и они 
перетаскиваются в поле регистрации, то регистрируется первое 
изображение или изображение, установленное как избранное, 
которое ближе всего к первому изображению.

1 Щелкните  [Slide show] и затем 
выберите [Create new/edit].
Отображается экран списка регистрации слайд-шоу.

●●Вы можете также отобразить ее, выбрав [Tools] → [Slide 
show]→[Create new/edit] из меню.

2 Выберите опцию [Create new] и 
щелкните [Next].

3 Выберите изображения для 
воспроизведения в слайд-шоу и 
перетащите и оставьте их в поле 
регистрации.
Они воспроизводятся в порядке слева направо.

●●Для изменения порядка 
Перетащите и отпустите изображения для установки в 
нужном Вам порядке.
●●Для удаления из слайд-шоу 
Выберите снимки, которые Вы не хотите воспроизводить, и 
щелкните [Remove from list].
●●Для повторного запуска регистрации с начала 
Щелкните по [Deselect all] в поле регистрации.

4 Щелкните [Next].

Поле регистрации
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5 Измените установки слайд-шоу.
●●Если Вы не хотите изменять установки, перейдите к пункту 6.
	Воспроизведение
Установите качество снимков для слайд-шоу.

Установка Рекомендуемая рабочая среда системы
[Picture quality priority] Core 2 Duo 2,4 ГГц и больше
[Normal] Pentium 4 1,6 ГГц и больше
[Speed priority] Pentium III 800 МГц и больше
[Repeat playback]: Воспроизведение повторяется.
	Установки эффектов
[Apply effect]: �Пока отображается снимок, используется 

выбранный эффект для изображения. 
Измените эффект из выпадающего меню.

[Do not apply effect]: �Интервал для переключения снимков 
можно установить между 1 и 99 секундами.

	Установки эффектов перехода видео
[Apply effect]: �Используется выбранный эффект для 

изображения, пока изображение переключается.
Измените эффект из выпадающего меню. 
Эффекты изображений устанавливаются в 
пределах диапазона 3 – 5 секунд.

[Do not apply effect]: �Проверьте, что никакие эффекты не 
активизированы при переключении изображения.

	Музыка
[Play music]: �Добавление музыки к слайд-шоу для 

воспроизведения.
[Default music (music file for the effect)]:

Воспроизведение музыки с эффектом изображения, 
установленным для [Effect setting].

[Specify a music file]: �Щелкните [Browse], выберите нужный 
Вам музыкальный файл и добавьте его 
к слайд-шоу для воспроизведения. 
Щелкните [Playback] для 
предварительного просмотра.

Советы
●●Примите, пожалуйста, во внимание, что, в зависимости от 
системной среды и используемого статуса, оно может не 
воспроизводиться нормально даже при наличии всех системных 
требований. Например:
- �При использовании этого программного обеспечения во время 

работы других программ.
- �При использовании компьютера с видеоадаптером, который 

разделяет память для хранения видеоданных и основную 
память.

- �При крайне ограниченной свободной памяти на системном диске 
или на целевом диске временных файлов.

●●Можно использовать музыкальные файлы в формате MP3, 
WMA, WAV или M4A. Тем не менее, некоторые файлы могут не 
воспроизводиться. (Содержание с защитой авторских прав и т.п.)
●●Если слайд-шоу останавливается во время воспроизведения, 
измените качество изображения слайд-шоу.
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6 Щелкните [Save].
Отображается окно [Save slide show].

●●Щелкните по [Playback] для воспроизведения созданного 
слайд-шоу.

7 Введите название и щелкните по 
[Save].
Слайд-шоу сохраняется.

8 Щелкните [Close].
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Воспроизведение сохраненных слайд-шоу

1 Щелкните  [Slide show] и затем 
выберите [Load].
Отображается экран списка регистрации слайд-шоу.

●●Вы можете также отобразить ее, выбрав [Tools] → [Slide 
show]→[Load] из меню.

2 Выберите файл и щелкните [Next].
Загружается сохраненное слайд-шоу, и слайд-шоу начинается.

Советы
●●Вы можете изменить имя из меню с вызовом правым щелчком 
миниатюры на экране списка регистрации.
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Воспроизведение слайд-шоу
Просмотр снимков

Удаление слайд-шоу
Удаление сохраненного слайд-шоу.

1 Щелкните  [Slide show] и затем 
выберите [Delete].
Отображается экран списка регистрации слайд-шоу.

●●Вы можете также отобразить ее, выбрав [Tools] → [Slide 
show]→[Delete] из меню.

2 Добавьте метку к файлу слайд-шоу, 
которое Вы хотите удалить.

3 Щелкните [Execute].

4 При отображении подтверждающего 
сообщения щелкните [Yes].
Слайд-шоу удаляется.

5 Щелкните [Close].
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Воспроизведение слайд-шоу
Просмотр снимков

Преобразование слайд-шоу в формат MPEG2
С помощью настоящего программного обеспечения слайд-шоу, созданные при использовании этого программного обеспечения, можно 
преобразовывать в широко используемый формат MPEG2.

1 Щелкните  [Slide show] и затем 
выберите [Convert MPEG2].
Отображается экран [Convert MPEG2].

●●Вы можете также отобразить ее, выбрав [Tools] → [Slide 
show]→[Convert MPEG2] из меню.

2 Щелкните по файлу слайд-шоу, 
который Вы хотите преобразовать.

3 Щелкните [Next].

4 Установите место сохранения и 
соотношение сторон экрана.

5 Щелкните [Execute].
Слайд-шоу изменяется в формат MPEG2.

6 Щелкните [OK].

7 Щелкните [Close].

Советы
●●За один раз можно преобразовать только один файл в формат 
MPEG2.
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Воспроизведение слайд-шоу
Просмотр снимков

Настройки для слайд-шоу
Вы можете установить эффекты перехода и музыку для выполнения немедленного воспроизведения слайд-шоу.

1 Выберите [Tools] → [Settings] из меню.
Отображается окно установок.

2 Щелкните [Slide show] — [Basic].

3 Измените установки.
Пункты установки такие же, как и при создании нового 
слайд-шоу. (→45)

4 Щелкните [Slide show] — [Movie].

5 Измените установки.
Пункты установки такие же, как и при создании нового 
слайд-шоу. (→45)

6 Щелкните [Apply].
●●При выполнении щелчка по [OK] применяются установки, и 
окно закрывается.
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Просмотр классифицированных изображений

Поиск снимков

Снимки, сохраненные на ПК, автоматически классифицируются в соответствии с информацией, например, такой как записанная сцена 
и ключевое слово.
Если Вы установите фильтр показа, выбрав пункт классификации, то Вы сможете выполнять поиск нужного Вам изображения из 
большого числа изображений.

1 Выберите папку, дату записи или 
название места для показа.
Для поиска среди всех снимков щелкните [All files] на 
отображении папок.

2 Если поле узкой установки не 
отображается, щелкните .

3 Щелкните [Category].

4 Выберите пункт классификации для 
показа.
В поле показа отображаются соответствующие 
изображения.

●●Для отмены сужения по пункту классификации щелкните 
[Deselect] ( A ).
●●При повторном выборе папки, даты записи или названия 
места для показа ограничение отменяется.

Советы
●●Невозможно выбрать несколько условий ограничения (пунктов 
классификации).
●●При выходе из программного обеспечения ограничение условий 
при классификации отменяется.

Количество классифицированных снимков

A
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Просмотр классифицированных изображений
Поиск снимков

	О пунктах классификации
Пункт классификации Описание

Favorite Классификация изображений, для которых избранные установлены с помощью поддерживаемой 
цифровой камеры или данного программного обеспечения.

CATEGORY Снимки классифицируются по соответствующим категориям, подобным функции [ВОСПР. КАТ.] 
цифровых камер LUMIX.

Категория Режимы сцены
Face Recognition Неподвижные изображения, классифицированные по распознаванию лица.
PORTRAIT etc. [ПОРТРЕТ], [i-ПОРТРЕТ], [РОВНАЯ КОЖА], [АВТОПОРТРЕТ], [ТРАНСФОРМ.],  

[НОЧН. ПОРТРЕТ], [i-НОЧН. ПОРТРЕТ], [РЕБЕНОК], [i-РЕБЕНОК]
SCENERY etc. [ПЕЙЗАЖ], [i-ПЕЙЗАЖ], [ЗАКАТ], [АЭРОСЪЕМКА], [i ЗАКАТ]
NIGHT 
SCENERY etc.

[НОЧН. ПОРТРЕТ], [i-НОЧН. ПОРТРЕТ], [НОЧН. ПЕЙЗАЖ], [i-НОЧН. ПЕЙЗАЖ], 
[ЗВЕЗДНОЕ НЕБО]

EVENTS [СПОРТ], [ВЕЧЕРИНКА], [СВЕЧИ], [ПАНОРАМИРОВ.], [ФЕЙЕРВЕРК], [ПЛЯЖ], [СНЕГ], 
[АЭРОСЪЕМКА]

BABY [РЕБЕНОК], [i-РЕБЕНОК]
PET [ДОМ.ЖИВОТНОЕ]
FOOD [ЕДА]
UNDERWATER [ПОДВОД. СЪЕМКА]
TRAVEL DATE [ДАТА ПОЕЗДКИ]
BURST [СЕРИЙН.СЪЕМК]

AUTO SCENE MODE Классификация снимков, которые записаны в автоматическом режиме сцены с автоматическим 
определением сцен.
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Просмотр классифицированных изображений
Поиск снимков

Пункт классификации Описание
Recording mode Снимки классифицируются по режиму сцены, в котором они были записаны.

●●Могут классифицироваться снимки в формате движущегося изображения AVCHD / AVCHD Lite или 
MPEG2, а также неподвижные изображения в формате RAW или JPEG с информацией Exif, сохраненной с 
информацией о сцене.
●●Изображения, записанные в Расширенном режиме сцен, классифицируются по подробным сценам в 
соответствующих папках [PORTRAIT], [SCENERY], [SPORTS], [NIGHT PORTRAIT] и [MACRO].
●●Классификация изображений, которые записаны в автоматическом интеллектуальном режиме по 
автоматически определяемым сценам ([i-ПОРТРЕТ], [i-ПЕЙЗАЖ] и пр.).

Model Name Снимки классифицируются по названию производителя и использованной для записи модели камеры.
●●Могут классифицироваться только неподвижные изображения в формате RAW или JPEG с информацией 
Exif, сохраненной с информацией о названии модели.

Keyword Снимки классифицируются по ключевым словам, которые были установлены при копировании на ПК.

Советы
●●Классификация может не выполняться в некоторых режимах 
записи или режимах сцены.
●●Виды режимов записи и режимов сцены могут различаться в 
зависимости от цифровой камеры.
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Распознавание лиц

Регистрация снимков лица

Советы
●●Если Вы зарегистрировали снимки лиц, имеющие различные 
выражения лиц, функция распознавания лиц будет улучшена.

О регистрации распознанного лица
Регистрация распознанного лица не гарантируется даже если его 
обладатель зарегистрирован.
Возможно также ошибочное распознание между родителями и 
детьми, братьями и сестрами, имеющими сходные черты лица.

●●Невозможно распознавание не человеческих лиц, например, 
морд (домашних животных) и т.п..
●●Распознание лица для регистрации невозможно или 
выполняется неправильно в таких случаях.
- Лицо не в анфас
- Лицо наклонено
- Слишком светлое или слишком темное лицо
- На лицо падают тени
- �Лицо скрыто за солнечными очками, очками, отражающими 

свет, за прической, шляпой и т.п.
- Лицо заснято в мелком размере
- �Лицо выходит за рамки кадра по причине слишком крупного 

плана или смещения к одной из сторон
- При слишком разнящемся выражении лица
- При возрастных изменениях в чертах лица

Если Вы регистрируете лицо (человека), которого Вы хотите 
классифицировать, лица на неподвижных изображениях, 
сохраненных на ПК, можно проанализировать на наличие этого 
лица и соответственно классифицировать.

Количество людей, которых 
можно зарегистрировать

Снимки лиц, которые можно 
зарегистрировать

20 человек 5 снимков на человека

	�Связь с функцией распознавания лиц цифровой 
камеры
Также когда цифровая камера с функцией распознавания 
лиц обнаруживает лица на неподвижных изображениях, и 
затем они копируются на ПК с помощью этого программного 
обеспечения, такая информация, как снимки лиц и имена 
регистрируются на ПК, и изображения автоматически 
классифицируются.

●●Снимки лиц, которые зарегистрированы на ПК, могут 
отличаться от снимков лиц, которые зарегистрированы с 
помощью установки распознавания лиц цифровой камеры.
●●При выполнении съемки неподвижного изображения, в котором 
после нажатия наполовину кнопки затвора записывается другой 
объект, что приводит к добавлению к этому неподвижному 
изображению информации о другом лице, возможна 
регистрация как другого лица.
●●Если неподвижное изображение, для которого распознавание 
лиц было зарегистрировано или изменено с помощью этого 
программного обеспечения, копируется на карту памяти, 
зарегистрированная информация не отображается на 
цифровой камере.
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Регистрация снимков лица
Распознавание лиц

1 Щелкните  [Face Recog.] и 
выберите [Register/edit face].
Отображается окно списка регистрации для 
распознавания лиц.

●●Вы можете также отобразить ее, выбрав [Tools]→ [Face 
Recognition] → [Register/edit face] из меню.

2 Щелкните [Add new].

3 Введите имя.
(Можно использовать до 32 символов (однобитных).)

4 Зарегистрируйте дату рождения.
При регистрации даты рождения в окне свойств может 
быть показан возраст во время записи снимка.
Если Вы не хотите регистрировать дату рождения, 
перейдите к шагу 5.
1 Щелкните [Register date of birth] для выбора метки.
2 Щелкните по  (  в Windows XP) для 

отображения календаря и установите дату 
рождения.

●●Вы можете щелкнуть по календарному отображению года 
для изменения показа в годах.

5 Щелкните [Next].



56

Распознавание лиц

Регистрация снимков лица

6 Выберите неподвижные изображения, 
которые содержат лицо для 
регистрации.
Если на неподвижных изображениях распознается лицо, 
отображаются снимки с лицами.

7 Перетащите и отпустите снимки лиц в 
поле регистрации.
Для одного человека можно зарегистрировать до 5 
снимков.

	�В случае неверной регистрации снимка с 
неправильно выбранным лицом

1
2

1 Выберите снимок лица для удаления из 
зарегистрированных снимков лиц.

2 Щелкните [Delete selected face picture].

8 Щелкните [Execute].

Поле регистрации
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Распознавание лиц

Регистрация снимков лица

9 Щелкните [Yes].
Регистрируется информация распознавания лица.

10 Для выхода из регистрации 
распознавания лиц или выполнения 
изменений щелкните [No].

●●Для продолжения регистрации или выполении изменений 
щелкните [Yes], чтобы вернуться к окну списка регистрации.

11 Щелкните [Close].

12 Для классификации снимков 
зарегистрированного человека 
щелкните [Yes].
Анализ начинается для неподвижных изображений, и они 
классифицируются.

●●Когда анализ заканчивается, отображается уведомление о 
завершении.

Состояние анализа

●●При щелчке по [No] классификация распознавания лиц не 
обновляется.
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Распознавание лиц

Анализ неподвижных изображений для классификации по распознаванию лица
Анализ сохраненных неподвижных изображений 

Классификация неподвижных изображений, находящихся в настоящее время в сохраняемых папках, с помощью зарегистрированных 
снимков лиц для распознавания лиц.

Советы
●●Для большого количества сохраненных снимков анализ займет 
много времени.
●●Даже если Вы измените снимки лиц для распознавания 
лиц, изменения не повлияют на классификацию, пока Вы не 
выполните анализ неподвижных изображений.
●●Если Вы установите автоматический анализ, классификация 
распознавания лиц всегда будет обновляться. (→59)

1 Щелкните  [Face Recog.] и затем 
выберите [Start face analysis].

●●Вы можете также начать анализ, выбрав [Tools] → [Face 
Recognition]→ [Start face analysis] из меню.

2 При отображении подтверждающего 
сообщения щелкните [Yes].
Анализ начинается для неподвижных изображений, и они 
классифицируются.

●●Когда анализ заканчивается, отображается уведомление о 
завершении.

	Для остановки процесса анализа
1 Щелкните [Cancel].

●●Вы можете отменить, щелкнув по  [Face Recog.] 
и выбрав [Cancel face analysis], или выбрав [Tools] → 
[Face Recognition] → [Cancel face analysis] из меню.

	�Для классификации по распознаванию лиц 
только неподвижных изображений в указанной 
папке
1 При показе папок выберите папку с 

неподвижными изображениями, которые Вы 
хотите классифицировать.

2 Выполните щелчок правой клавишей и выберите 
[Folder face analysis].

Состояние анализа Отмена анализа
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Анализ неподвижных изображений для классификации по распознаванию лица
Распознавание лиц

Выполнение автоматического анализа распознавания лиц
Когда снимки копируются на ПК или регистрируется новая информация распознавания лица, можно выполнить автоматический анализ 
сохраненных снимков для самого последнего обновления классификации распознавания лиц.

1 Выберите [Tools] → [Settings] из меню.
Отображается окно установок.

2 Щелкните [General] — [Registration 
folder].

3 Установите, выполнять ли 
автоматический анализ.
При установленной метки снимки автоматически 
анализируются для постоянного обновления 
классификации распознавания лиц.

4 Щелкните [Apply].
●●При щелчке по [OK] применяются установки, и окно 
закрывается.
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Распознавание лиц

Изменение зарегистрированного содержания

1 Щелкните  [Face Recog.] и затем 
выберите [Register/edit face].
Отображается окно списка регистрации для 
распознавания лиц.

●●Вы можете также отобразить ее, выбрав [Tools] → [Face 
Recognition] → [Register/edit face] из меню.

2 Щелкните по человеку, которого Вы 
хотите изменить.

3 Исправьте имя.
(Можно использовать до 32 символов (однобитных).)

4 Исправьте дату рождения.

5 Щелкните [Next].
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Распознавание лиц

Изменение зарегистрированного содержания

Поле регистрации

6 Добавьте или удалите снимок лица.
	Для добавления снимка лица

1 Выберите снимок для добавления.
2 Перетащите и отпустите снимки лиц в поле 

регистрации.

	Для удаления снимка лица
1 Выберите снимок лица для удаления из снимков 

лиц в поле регистрации.
2 Щелкните [Delete selected face picture].

7 Щелкните [Execute].

8 Щелкните [Yes].
Содержание регистрируется.

9 Для выхода из регистрации 
или изменения информации 
распознавания лиц щелкните [No].

●●Для продолжения регистрации или изменений щелкните 
[Yes], чтобы вернуться к окну списка регистрации.

10 Щелкните по [Close] и выберите, 
выполнять ли еще раз анализ лиц и 
классификацию, и щелкните [Yes] для 
выхода.
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Распознавание лиц

Показ только неподвижных изображений, содержащих указанного человека

1 Выберите папку, дату записи или 
название места для показа.
Для поиска среди всех снимков щелкните [All files] на 
отображении папок.

2 Если поле узкой установки не 
отображается, щелкните .

3 Щелкните [Face Recog.].

4 В списке распознавания лиц выберите 
человека, которого Вы хотите 
показать.
В поле показа отображаются соответствующие снимки.

●●Для отмены сужения по распознаванию лиц щелкните 
[Deselect] ( A ).
●●При повторном выборе папки, даты записи или названия 
места для показа ограничение отменяется.

Советы
●●Щелкните правой клавишей по имени, показанному в списке 
распознавания лиц, и выберите [Change Name] для его 
изменения. Можно объединить несколько списков, присваивая 
одно и то же имя каждому из нужных списков. Однако 
невозможно изменить имена, уже зарегистрированные для 
распознавания лица.
●●Когда имя не зарегистрировано в установках распознавания лица 
на цифровой камере, имеющей функцию распознавания лиц, в 
списке распознавания лиц имена не отображаются.
●●При выходе из этого программного обеспечения ограничение 
условий по распознаванию лиц отменяется.

Количество снимков, на которых имеется 
человек

Список распознавания лиц

A
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Распознавание лиц

Исправление классификаций неправильно выбранных людей

1 Выберите [All files] в папке для показа.

2 Если поле узкой установки не 
отображается, щелкните .

3 Щелкните [Face Recog.].

4 В списке распознавания лиц выберите 
зарегистрированного человека.

5 Перетащите и отпустите неверно 
классифицированные неподвижные 
изображения на правильное назначение для 
классификации в списке распознавания лиц.

6 При отображении подтверждающего 
сообщения щелкните [Yes].
Правильно отображается снимок с распознаванием лица.

7 Щелкните [OK].
	Для удаления из классификации

1 В списке распознавания лиц выберите 
зарегистрированного человека.

2 Щелкните правой клавишей мыши по 
неподвижному изображению и выберите [Delete].

3 При отображении подтверждающего сообщения 
щелкните [Yes].

4 Щелкните [OK].

Список распознавания лиц

Советы
●●Неподвижные изображения, удаленные из категории, не будут 
возвращены в свою первоначальную категорию, даже если выбор 
снова ограничивается распознаванием лица. 
Для возврата неподвижного изображения в его первоначальную 
категорию используйте операцию перетаскивания, чтобы 
переместить его в нужную категорию списка распознавания лиц.
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Распознавание лиц

Ручная классификация неподвижных изображений, для которых распознавание лиц не работает

Подготовка:
Отметьте неподвижные изображения, для которых не работает 
распознавание лиц.

Вы можете вручную классифицировать неподвижные изображения, для которых автоматическое распознавание лиц не работает.

Список распознавания лиц

1 Отобразите неподвижное 
изображение, которое Вы хотите 
классифицировать по распознаванию 
лиц.

2 Если поле узкой установки не 
отображается, щелкните .

3 Щелкните [Face Recog.].

4 Перетащите и отпустите неподвижное 
изображение на назначение 
для классификации в списке 
распознавания лиц.

5 При отображении подтверждающего 
сообщения щелкните [Yes].
Оно добавляется к показу снимков с распознаванием лиц.

6 Щелкните [OK].



65

Распознавание лиц

Отмена выбора регистрации распознавания лиц 

Советы
●●Даже если удаляется регистрация распознавания лиц, исходные 
неподвижные изображения не удаляются.
●●Щелкните правой клавишей по имени в списке распознавания 
лиц и выберите [Delete category results] для удаления имени. 
Регистрации распознавания лиц удалить невозможно.

1 Щелкните  [Face Recog.] и 
выберите [Remove from list].
Отображается окно списка регистрации для 
распознавания лиц.

●●Вы можете также отобразить ее, выбрав [Tools] → [Face 
Recognition] → [Remove from list] из меню.

2 Выберите лицо для отмены и 
добавьте метку.

3 Щелкните [Execute].

4 При отображении подтверждающего 
сообщения щелкните [Yes].
Оно удаляется из списка регистрации.

5 Щелкните [OK].
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Поворот снимков

Редактирование неподвижных изображений

Советы
●●Для неподвижных изображений в формате RAW или формате 
JPEG, имеющих информацию Exif, поворот выполняется 
только при исправлении информации Exif. Для определенного 
программного обеспечения возможно не получится повернуть 
снимок.
●●При одновременном повороте большого количества снимков 
окончание данного процесса может занять некоторое время.

1 Выберите неподвижное изображение 
для поворота.

2 Щелкните  или .
●●Вы можете поворачивать снимок, выбрав [Edit] → [Edit 
still picture] → [Counter-clockwise Rotation] или [Clockwise 
Rotation] из меню.

3 При отображении подтверждающего 
сообщения щелкните [Yes].
Снимок поворачивается на 90 градусов по часовой 
стрелке или против часовой стрелки.

	�При повороте неподвижного изображения без 
информации Exif 
При повороте неподвижного изображения без 
информации Exif заново создается неподвижное 
изображение в формате JPEG, имеющее информацию 
Exif.
1 При отображении подтверждающего сообщения 

щелкните [OK].
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Редактирование неподвижных изображений

Изменение размера снимка

1 Щелкните  [Edit] и затем выберите 
[Resize].
Отображается экран [Resize].

●●Вы можете также изменить размер снимка, выбрав [Edit] → 
[Edit still picture] → [Resize] из меню.

2 Выберите изображение, отметив его, и 
щелкните [Next].

3 Установите размер после изменения.
	Заданный размер

A : Зафиксируйте соотношение сторон.
B : Установите ширину снимка после изменения.
C : Установите высоту снимка после изменения.

	Коэффициент увеличения/уменьшения
D : �Установите коэффициент увеличения для размера 

снимка после изменения в диапазоне от 1 % до  
200 %.

B
C

A

D
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Изменение размера снимка
Редактирование неподвижных изображений

Советы
●●В случае выбора и изменения размера нескольких изображений 
для завершения процесса может потребоваться время.

4 Щелкните [Save Settings].
	Удаление исходного файла

A : Удалите исходный снимок.
	Папка назначения для сохранения

B : Сохраните в той же папке, что и исходный снимок.
C : �Сохраните в другой папке. Щелкните [Browse] и 

выберите назначение для сохранения.
	Соотношение сжатия JPEG 
D : �Для формата JPEG соотношение сжатия можно 

устанавливать регулятором. 
При перемещении регулятора влево размер данных 
снимка становится меньше и качество снимка ухудшается.

5 Щелкните [Execute].

6 При отображении подтверждающего 
сообщения щелкните [Yes].
Размер снимка изменяется в соответствии с установками.

	�О подтверждающем сообщении для информации 
ретуширования печати 
При установке перезаписи исходного изображения 
в положение [Save Settings], отображается 
подтверждающее сообщения для предупреждения утери 
информации ретуширования печати.
При щелчке по [Yes] исходный снимок перезаписывается 
на снимок с измененным размером.

7 Щелкните [OK].

8 Щелкните [Close].

B
C

A

D
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Редактирование неподвижных изображений

Ретуширование снимков (изменения яркости или цветности)

1 Щелкните  [Edit] и затем выберите 
[Retouch].
Отображается экран [Retouch].

●●Вы можете также ретушировать снимок, выбрав [Edit] → 
[Edit still picture] → [Retouch] из меню.

2 Выберите снимок и щелкните 
[Execute].
Экран изменяется для отображения окна ретуширования 
снимка.
A : �Здесь находятся меню функции ретуширования 

снимков.
B : Кнопки для часто используемых функций.
C : Возврат к основному окну.
D : Окно снимка.
E : Панель редактирования.

		[Picture]: �Показаны снимки, которые можно 
ретушировать.

		[Effect]: �Операционная панель для функции 
ретуширования.

A

B

C

D

E
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Ретуширование снимков (изменения яркости или цветности)
Редактирование неподвижных изображений

3 Ретуширование снимка.
	Увеличение снимка.

1 Щелкните .
2 Щелкните окно снимка.

Щелкните правой клавишей мыши для уменьшения размера.
●●Для отображения исходного размера щелкните .
●●Выберите [View] → [Fit window] для показа всего, что 
находится в окне снимка.
●●Выберите [View] → [Zoom] из меню для выбора увеличения.

	Поворот снимка.
Щелкните  (поворот на 90 градусов против часовой 
стрелки) или  (поворот на 90 градусов по часовой стрелке).
	Изменение яркости или цветности изображения.

1 Щелкните [Effect].
2 Выберите функцию ретуширования.
3 Настройте эффект.

	Отмена предыдущей операции.
Щелкните .

●●Для восстановления отмененной операции щелкните .
●●Для возврата снимка в исходном состоянии щелкните .

4 Выберите [File] → [Save] или [Save 
As…] из меню и сохраните снимок.

5 Щелкните [Return to original screen].
Экран изменяется для отображения основного окна.

●●Вы можете дважды щелкнуть другой снимок из [Picture] для 
продолжения ретуширования снимков.

6 Щелкните [Close].

Советы
●●Для отображения снимков, которые были сохранены в другой 
папке с помощью [Save As…], добавьте папку регистрации в 
[Tools] → [Settings]. (→27)
●●Некоторые размеры снимков невозможно полностью отобразить 
в окне снимка, даже если выбрана опция [Fit window].
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Редактирование неподвижных изображений

Ретуширование снимков (изменения яркости или цветности)

Об эффектах
	Яркость и контрастность

1 3
2

1 Щелкните .
2 Выберите цвет для ретуширования.
3 Переместите регулятор для настройки эффекта.

	Оттенок и насыщенность

1 2

1 Щелкните .
2 Переместите регулятор для настройки эффекта.

	Резкость

1 2

1 Щелкните .
2 Переместите регулятор для настройки эффекта.

	Сепия

1

1 Щелкните .

	Негатив

1

1 Щелкните .

	Шкала серого

1
1 Щелкните .
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Ретуширование снимков (изменения яркости или цветности)
Редактирование неподвижных изображений

	Устранение эффекта красных глаз

1 3

2

1 Щелкните .
2 Расположите рамку над глазом, ставшим красным из-

за вспышки.
3 Щелкните [Apply].

Советы
●●Устранение эффекта красных глаз и автоматическое 
ретуширование отличаются в зависимости от снимка.
●●Когда снимок напечатан с включением функции коррекции 
качества изображения, не выполняйте автокоррекцию с функцией 
ретуши. Изображение может быть чрезмерно откорректировано.

	Авто улучшение

1
1 Щелкните .

	Вырезание
1 Выберите [Effect] → [Cropping Picture…] из меню.

2

2 Настройте рамку для указания области вырезания.
●●Вы можете также указать область вырезания путем ввода 
параметров [Width] и [Height] для [Picture Size].

3 Щелкните [OK].
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Редактирование неподвижных изображений

Создание панорамного изображения с помощью совмещения снимков

Поле регистрации

1 Щелкните  [Edit] и затем выберите 
[Panorama stitch].
Отображается экран [Panorama stitch].

●●Вы можете также отобразить ее, выбрав [Edit] → [Edit still 
picture] → [Panorama stitch] из меню.

2 Выберите неподвижные изображения 
для совмещения в виде панорамы, 
затем перетащите и оставьте их в 
области регистрации.
Изображения будут склеиваться слева направо. Для 
получения панорамы вертикального типа порядок 
слева направо изменится на порядок сверху вниз. 
Количество неподвижных изображений, которые можно 
зарегистрировать, будет различаться в зависимости от 
типа панорамы. Перейдите к пункту 3.

●●Для изменения порядка  
Перетащите и оставьте неподвижные изображения, чтобы 
задать правильный порядок.
●●Для удаления изображений из совмещенной панорамы  
Выберите неподвижные изображения, которые не нужно 
совмещать, и щелкните [Remove from list].
●●Для повторного запуска регистрации с начала  
Щелкните [Deselect all] в поле регистрации.

Объединяя несколько неподвижных изображений, Вы сможете создать панорамное изображение.

Советы
●●Для регистрации рекомендуется использовать фотографии, 
записанные [ВСПОМ. ПАНОР.] LUMIX.
●●При включенной функции [Select automatically by group], когда 
выбрано одно неподвижное изображение, автоматически будет 
выбираться каждое неподвижное изображение, имеющее 
отношение к этому неподвижному изображению. Изображениями, 
которые распознаны как часть одинаковой группы, с помощью 
этой функции, являются изображения одинакового размера, 
сохраненные с помощью функции LUMIX [ВСПОМ. ПАНОР.] и 
снятые в пределах 40 секунд.
●●Изображения разных размеров и смешанные портретные/ 
пейзажные изображения невозможно совместить вместе в виде 
панорамы.
●●Если отображение группы установлено для неподвижных 
изображений, записанных в режиме серии, и они 
перетаскиваются в поле регистрации, то регистрируется первое 
изображение или изображение, установленное как избранное, 
которое ближе всего к первому изображению.
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Редактирование неподвижных изображений

Создание панорамного изображения с помощью совмещения снимков

3 Выберите тип панорамы.
Горизонтальный тип: �Горизонтальное совмещение 

неподвижных изображений. Можно 
зарегистрировать от 2 до 16 
неподвижных изображений.

360 градусов: �Горизонтальное совмещение изображений 
в пределах 360 градусов с центром 
в положении, в котором находится 
снимающий изображение человек. Можно 
зарегистрировать от 6 до 32 неподвижных 
изображений.

Вертикальный тип: �Вертикальное совмещение 
неподвижных изображений. 
Можно зарегистрировать от 2 до 8 
неподвижных изображений.

4 Щелкните [Execute].
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Редактирование неподвижных изображений

Создание панорамного изображения с помощью совмещения снимков

5 Проверьте порядок неподвижных 
изображений, которые будут 
совмещаться, и выберите выходной 
размер.

	Выходной размер
:�Размер готового совмещенного изображения не 
изменяется. Выберите в случае необходимости 
печати.

:�Размер совмещенного изображения уменьшается. 
Выберите в случае отображения на ПК и т.п.

:�Размер совмещенного изображения уменьшается. 
Выберите в случае прикрепления к сообщению 
электронной почты.

●●Порядок слева направо или порядок сверху вниз для 
совмещаемых фотографий можно изменить с помощью .
●●Возможно обратное переключение на опцию [Horizontal 
type] или [360 degrees], если тип панорамы был 
установлен на [Horizontal type] или [360 degrees] в пункте 
3 или если имеется более 6 неподвижных изображений.

6 Щелкните [Stitch].

7 Используйте красную рамку 
обрезания для указания области, 
которую нужно вырезать и сохранить.

Советы
●●В некоторых случаях совмещение может быть невозможно для 
выбранного выходного размера в зависимости от используемого 
Вами ПК. В таких случаях либо уменьшите количество совмещаемых 
фотоснимков, либо выберите меньший выходной размер.
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Редактирование неподвижных изображений

Создание панорамного изображения с помощью совмещения снимков

Советы
●●В зависимости от выбранных фотографий и последовательности, 
в которой фотографии были зарегистрированы, они могут 
соединиться неправильно.
●●Движущиеся изображения QuickTime VR воспроизводятся с 
помощью QuickTime Player при выполнении двойного щелчка по 
миниатюре.
●●Если движущиеся изображения QuickTime VR не воспроизводятся 
при двойном щелчке, щелкните правой клавишей по значку в 
Explorer и объедините их с QuickTime, используя Properties. 
●●Печать панорамных изображений (→86)
●●Настройка панорамных изображений (формата JPEG) (→69)
●●Для некоторых программ отображение сохраненного панорамного 
изображения (формат JPEG) поворачивается.

8 Щелкните [Save].
Отображается экран для ввода имени файла.

9 Введите имя файла, выберите формат 
сохранения панорамы и сохраните.

●●Формат JPEG (расширение: .JPG)  
Можно сохранять все типы панорамных изображений 
(горизонтального типа, 360 градусов, вертикального типа). 
●●Формат QuickTime (расширение: .MOV)  
Можно сохранять панорамные изображения 
горизонтального типа или 360 градусов.

10 Щелкните [Exit].
●●Возврат к основному окну.
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Преобразование формата данных

Обработка неподвижных изображений

Советы
●●Даже если Вы преобразовываете неподвижное изображение в 
формате JPEG до меньшего сжатия (более высокое качество), 
чем оригинальные данные, качество не улучшится.

1 Выберите [Tools] → [Still picture tool] → 
[Format conversion] из меню.
Отображается экран [Format conversion].

2 Выберите изображение, отметив его, и щелкните [Next].

3 Выберите установки сохранения.
	Удаление исходного файла

A : Удалите исходный снимок.
	Папка назначения для сохранения

B : Сохраните в той же папке, что и исходный снимок.
C : �Сохраните в другой папке. Щелкните [Browse] и 

выберите назначение для сохранения.
	Соотношение сжатия JPEG 
D : �Для формата JPEG соотношение сжатия можно 

устанавливать регулятором. 
При перемещении регулятора влево размер данных 
снимка становится меньше и качество снимка ухудшается.

4 Щелкните [Execute].

5 При отображении подтверждающего 
сообщения щелкните [Yes].
Формат данных снимка изменяется.

6 Щелкните [OK].

7 Щелкните [Close].

Вы можете преобразовывать неподвижные изображения в формате BMP и в формате TIFF в формат JPEG. Вы также можете 
изменять соотношение сжатия неподвижных изображений в формате JPEG.

B
C

A

D
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Обработка неподвижных изображений

Одновременное изменение имен нескольких файлов снимков

1 Выберите [Tools] → [Still picture tool] → 
[Batch Rename] из меню.
Отображается экран [Batch Rename].

2 Выберите изображение, отметив его, и 
щелкните [Next].

3 Установите имя файла.

4 Щелкните [Execute].

5 При отображении подтверждающего 
сообщения щелкните [Yes].
Имена файлов изменяются в соответствии с установками.

6 Щелкните [OK].

7 Щелкните [Close].

Советы
●●Если файл с одинаковым именем и одинаковым 
последовательным номером уже существует, данный номер будет 
пропущен, и будет переименован следующий файл.

	Установки имени
Установка символьной строки
A : �Имя файла представляет собой комбинацию введенных 

здесь символов и серийного номера. 
(Можно использовать до 32 символов (однобитных).)

B : �Имя файла представляет собой комбинацию исходного 
имени файла и серийного номера.

Установка номера
C : �Доступный диапазон для начального номера серийного 

номера составляет от 0 до 1 000.
D : �Доступный диапазон для количества цифр серийного 

номера составляет от 1 до 9.
E : �Доступный диапазон для шага серийного номера 

составляет от 1 до 1 000.
Установка порядка
F : �Установите порядок серийной строки и номера, которые 

будут использоваться в качестве имени файла.
	Файлы, которые нужно переименовать
G : Выберите имя файла после преобразования.

G

A

F

B
C
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D
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Обработка неподвижных изображений

Изменение даты записи
Вы можете исправить дату записи и время снимков, которые были записаны в случае неправильной установки времени цифровой 
камеры.
Установив промежуток между действительным временем записи и записанным временем (время исправления) с другими снимками, 
Вы сможете исправить одновременно дату записи нескольких снимков, которые были записаны при неправильной установке времени.

Пример: 

Снимок Время записи до изменения

При установке даты и 
времени после изменения

1 июля 2010 г.
12:00:00

При установке времени 
исправления

[Date correction]			546
[Time correction]				+12:00:00

Справочный 
снимок

1 января 2009 г.
0:00:00

1 июля 2010 г.
12:00:00

1 июля 2010 г.
12:00:00

Выбранный 
снимок

1 января 2009 г.
1:00:10

1 июля 2010 г.
12:00:00

1 июля 2010 г.
13:00:10

Выбранный 
снимок

2 января 2009 г.
10:00:30

1 июля 2010 г.
12:00:00

2 июля 2010 г. 
22:00:30
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Изменение даты записи
Обработка неподвижных изображений

1 Выберите [Tools] → [Still picture tool] → 
[Change recording date] из меню.
Отображается экран [Change recording date].

●●Вы можете изменять дату записи только для изображений 
JPEG с информацией Exif (содержащей информацию о дате 
записи). При отображении подтверждающего сообщения 
щелкните [OK].

2 Выберите изображение, отметив его, и 
щелкните [Next].

3 Выберите один снимок для 
использования в качестве справки.
A : Дата и время записи выбранного снимка
B : Дата и время записи после изменения

4 Установите дату и время записи после 
изменения.

	�Для установки правильной даты и времени записи
1 Щелкните [Date and time setting for after the change].
2 Щелкните по  (  в Windows XP) для 

отображения календаря и установите дату записи.
●●Вы можете щелкнуть по календарному отображению года 
для изменения показа в годах.

3 Установите время записи.

	Для установки разницы по времени 
1 Щелкните [Correction time (offset)].
2 Щелкните [Date correction] и установите количество 

дней для исправления даты.
3 Щелкните [Time correction] и установите количество 

часов для исправления времени.

A
B



81

Изменение даты записи
Обработка неподвижных изображений

5 Щелкните [Save Settings].
A : Перезапишите и сохраните.
B : Сохраните в той же папке, что и исходный снимок.
C : �Сохраните в другой папке. Щелкните [Browse] и 

выберите назначение для сохранения.

6 Щелкните [Execute].

7 При отображении подтверждающего 
сообщения щелкните [Yes].
Дата и время записи изменяются для установленных даты 
и времени.

8 Щелкните [OK].

9 Щелкните [Close].

Советы
●●Измените дату записи в пределах диапазона от 1971 до 2037 г.г.
●●В снимках, записанных в режиме [РЕБЕНОК], режиме [ДОМ.
ЖИВОТНОЕ] или посредством функции [ДАТА ПОЕЗДКИ] 
цифровой камерой, поддерживающей эти функции, возраст в 
месяцах/годах или количество дней поездки не изменятся даже 
при смене даты записи.

B
C

A



82

Обработка неподвижных изображений

Использование снимка в качестве обоев

1 Выберите [Tools] → [Still picture tool] → 
[Register as wallpaper] из меню.
Отображается экран [Register as wallpaper].

2 Выберите одно изображение и 
щелкните [Execute].

3 Выберите положение отображения.
[Fit to screen]: �Показ изображений, соответствующих 

размеру рабочего стола.
[Center]: Отображение в центре рабочего стола.
[Tile]: �Отображение с помощью копирования и 

размещения по всему экрану.

4 Щелкните [OK].
Установлено в качестве обоев.

	Если снимок больше, чем размер рабочего стола
Отображается окно подтверждения для изменения 
размера.
Если Вы хотите уменьшить снимок до размера рабочего 
стола, щелкните [Yes].

5 Щелкните [Close].

Советы
●●Если обои не отображаются, щелкните по рабочему столу и 
нажмите клавишу [F5].
●●Если снимок с соотношением сторон, отличающимся от 
соотношения сторон экрана ПК, устанавливается в качестве 
обоев с опцией [Fit to screen], соотношение сторон будет 
изменено. В таком случае установите [Center] или [Tile].
●● [PHOTOfunSTUDIO.bmp] будет создано в Pictures (My Pictures).
●●При выполнении группового показа неподвижных изображений, 
записанных в режиме серии, первое неподвижное изображение 
в группе или неподвижное изображение, установленное как 
избранное, которое находится ближе всего к началу группы, 
устанавливается в качестве обоев.
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Обработка неподвижных изображений

Добавление информации о дате и названии (заголовок) к снимку
Вы можете создать данные неподвижного изображения, к которым добавляется такая информация, как дата записи или заголовок.

1 Выберите [Tools] → [Still picture tool] → 
[Burn-in] из меню.
Отображается экран [Burn-in].

●●Вы можете добавлять информацию только к изображениям 
JPEG с информацией Exif. При отображении 
подтверждающего сообщения щелкните [OK].

2 Выберите изображение, отметив его, и 
щелкните [Next].
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Обработка неподвижных изображений

Добавление информации о дате и названии (заголовок) к снимку

3 Установите пункты, которые Вы 
хотите записать.
A : �Введите даты записи.
B : �Введите количество дней поездки.

(Только снимки, записанные с [ДАТА ПОЕЗДКИ] на 
цифровой камере, совместимой с функцией [ДАТА 
ПОЕЗДКИ].)

C : �Введите возраст в месяцах/годах.
(Только снимки, записанные с [ВОЗРАСТ] на цифровой 
камере, совместимой с режимом [РЕБЕНОК] и 
режимом [ДОМ.ЖИВОТНОЕ].)

D : �Запись места назначения, выбранного в режиме 
путешествия.

E : �Запись имен, зарегистрированных для распознавания 
лиц в режиме [РЕБЕНОК] и режиме [ДОМ.ЖИВОТНОЕ].

F : �Запись информации заголовка.
G : �Запись названия страны, области или 

административного района, а также названия города 
или населенного пункта, где выполнена запись.

H : �Запись информации, записанной с помощью функции 
GPS, например, название ориентира.

B
C

A

D
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F
G
H
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Добавление информации о дате и названии (заголовок) к снимку
Обработка неподвижных изображений

Советы
●●К нижней правой части снимка записывается до 9 строк в порядке 
информации даты записи, количества дней путешествия или 
возраста в месяцах/годах и информации о месте назначения, 
именах и заголовке, а также названий мест (названия страны, 
области или административного района, названия города или 
населенного пункта и ориентиры.)
●●Невозможно записать дальнейшую информацию для 
изображений, на которых информация о дате или заголовке уже 
была записана с помощью функций [ОТПЕЧ.ДАТЫ] или [ОТПЕЧ 
СИМВ] цифровой камеры.
(Если имеются изображения с информацией о дате и названии, 
вставленной не с помощью функций [ОТПЕЧ.ДАТЫ] и [ОТПЕЧ 
СИМВ], такое сообщение не появится, поэтому внимательно 
проверьте содержимое до выполнения вставки.)
●●Цвет и размер знаков, используемых для вставленной 
информации о дате и названии, не может меняться.
●●После завершения записи качество снимка может ухудшиться.
●●Дата может быть неправильно добавлена и напечатана на 
снимке, если она не была выставлена на цифровой камере в 
момент съемки или если съемка проводилась цифровой камерой 
от другого изготовителя, а не Panasonic.

4 Щелкните [Save Settings]
A : Перезапись исходного снимка.
B : Сохраните в той же папке, что и исходный снимок.
C : �Сохраните в другой папке. Щелкните [Browse] и 

выберите назначение для сохранения.

5 Щелкните [Execute].

6 При отображении подтверждающего 
сообщения щелкните [Yes].
Снимок создается с такой информацией, как записанные 
дата или заголовок, в соответствии с установками.

	�О подтверждающем сообщении для информации 
ретуширования печати
При установке перезаписи исходного изображения 
в положение [Save Settings], отображается 
подтверждающее сообщения для предупреждения утери 
информации ретуширования печати.
При щелчке по [Yes] исходный снимок перезаписывается 
на снимок с записанной информацией, такой как дата 
или заголовок.

7 Щелкните [OK].

8 Щелкните [Close].

B
C

A
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Использование снимков

Печать снимка
Вы можете напечатать много снимков на одном листе или расположить вместе много миниатюр и напечатать их вместе с различной 
информацией.
Можно печатать неподвижные изображения в формате BMP, JPEG и TIFF.
(Только для Windows 7 и Windows Vista можно печатать снимки в формате RAW (с расширением .RW2); однако процесс печати может 
потребовать определенного времени. Более того, иногда печать может не выполняться в зависимости от данных.)
Одновременно можно напечатать до 1 000 снимков.
В этом разделе описана процедура печати одного снимка на одном листе бумаги.

Подготовка:
●●Подсоедините принтер к ПК и выполните установки принтера 
для Windows.
●●Если Вы хотите правильно расположить направление 
текстовой информации для печати, например, дату на снимке, 
поверните снимок нужным образом.

1 Щелкните  [Print].
Отображается экран [Print].

●●Вы также можете отобразить ее, выбрав [Output] → [Print] из 
меню.

2 Выберите изображение, отметив его, и 
щелкните [Execute].
Отображается окно печати.

●●Для установки информации для печати (→88)
●●Для установки принтера (→90)
●●Для печати нескольких снимков на одном листе бумаги (→91)
●●Для печати нескольких миниатюр на одном листе бумаги 
(→92)
●●Для печати информации о файле или информации о камере 
рядом со снимками (→93)
●●Для печати записанных снимков в Простом режиме (→94)

3 Выберите [Print 1 picture on a page].

4 Выберите направление бумаги.
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Печать снимка
Использование снимков

5 Выберите информацию и другие пункты для печати.
[Show date]: �Печатается дата записи. 

Если для снимка записаны количество дней путешествия 
или возраст в месяцах/годах, они также печатаются.

[Show title information]: Печатается информация о заголовке.
[Show Face Recog. name]: �Печатается имя, зарегистрированное 

для функции распознавания лиц.
[Frame]: �Вокруг снимка помещается рамка.

Щелкните  для изменения цвета рамки.
[Trimming]: �Обрежьте снимок так, чтобы отпечаток 

соответствовал бумаге. 
Щелкните [Top], [Bottom], [Left] и [Right] для 
настройки положения отпечатка. 
Щелкните [Centring] для перемещения снимка в центр.

[Categorisation information]: �Печатаются комментарии или 
ключевые слова. (→41, 52)

6 Проверьте предварительный просмотр печати.
Щелкните   для проверки предварительного 
просмотра печати других снимков.

●●Предварительный просмотр печати также изменяется, если 
Вы непосредственно вводите номер страницы.

[Enlarged view]: �Показ увеличенного вида 
предварительного просмотра печати.

7 Щелкните [Print start].
Начинается печать.

●●Для остановки печати в процессе выполнения щелкните [Cancel].

8 Щелкните [Close].

9 Щелкните [Close] после возврата к 
экрану [Print].

Советы
●●При наличии снимков, напечатанных с информацией о дате и 
названии с цифровой камеры, которая совместима с функциями 
[ОТПЕЧ.ДАТЫ] и [ОТПЕЧ СИМВ] появляется сообщение “Те 
же данные будут отпечатаны поверх существующих даты и 
информации о названии”, когда проверяется [Show date] или 
[Show title information].
- �Если щелкнуть по [Yes], будут отпечатаны дата съемки, 

информация о заголовке, имя распознанного лица и т.д.
- �При щелчке по [No] метки удаляются.  

(Если имеются снимки с информацией о дате и заголовке, 
записанной с помощью другой функции, сообщение не появится, 
поэтому внимательно проверьте содержание в [Print Preview:].)

●●Если [Show date] выбрано для снимка, не имеющего информации 
о дате записи, печатается дата последнего обновления.
●●Дата может быть напечатана неправильно для снимков, 
записанных до установления даты или на цифровых камерах, 
отличных от Panasonic.
●●Формат отображения даты соответствует установкам Windows 
(Региональные установки).
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Использование снимков

Печать снимка

Установка информации для печати

1 Щелкните [Options] в окне печати.

2 Установите информацию для печати.
	Установки даты

A : Печать дня путешествия.
B : �Печать возраста ребенка или домашнего животного в 

месяцах/годах.
	�Установки названия информации о заголовке
C : �Печать названия места или ориентиров для места 

назначения, имени и возраста для ребенка или 
домашнего животного, а также заголовка.

	Pаспознавании лиц
D : Печать возраста.

	Установки информации о классификации
E : Печать комментариев.
F : Печать ключевых слов.
G : Создание прозрачного фона.

	Установка шрифта 
H : Установка шрифтов.

	Обычные установки
I : Выбор цвета, которым будут печататься символы.
J : Выбор позиции печати.

A B

J

C

E
D

G

F

H

I
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Использование снимков

Печать снимка

Установка информации для печати

3 Щелкните [OK].
Экран вернется к окну печати.

Советы
●●Информация о заголовке или имя распознанного лица обычно 
печатается сверху слева или снизу слева, но если будет 
происходить наложение на позицию установки даты, они будут 
напечатаны с правой стороны снимка.
●●Если заголовок содержит слишком много букв, он может 
накладываться на дату. Этого можно избежать, изменив 
установку положения отображения.
●●Могут быть распечатаны названия мест и ориентиров, 
содержащие до 36 двухбайтовых символов (или до 72 
однобайтовых символов). В зависимости от бумаги и настроек 
шрифта, символы в конце названий мест и ориентиров могут не 
напечататься, если слова содержат слишком много символов.



90

Использование снимков

Печать снимка

Настройка принтера

1 Щелкните [Print settings] в окне 
печати.

2 Выберите принтер.
●●Щелкните [Properties…] для отображения окна свойств 
принтера.

3 Настройте принтер.
A : �Выполните печать без рамок, если это 

поддерживается принтером.
B : Выбор бумаги.
C : �Вы можете выбрать качество бумаги с помощью 

установок бумаги.
D : �Используйте информацию PRINT Image Matching или 

информацию Exif Print для ретуширования снимка, 
если это поддерживается принтером.

E : Печать всех выбранных снимков.
F : �Печать только снимков, отображаемых в 

предварительном просмотре печати.
G : Установите количества экземпляров печати.

4 Щелкните [OK].
Экран вернется к окну печати.

Советы
●●Если Вы используете принтер, совместимый с модулем Epson 
EasyPrint, Вы можете выбрать опции [Borderless] и [Paper Type:] 
после установки модуля, поставляемого с принтером.

A
C

B

D F
G

E
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Печать снимка

Печать нескольких снимков на одном листе бумаги

1 Выберите печать нескольких снимков 
из [Printing Type:] в окне печати.

Пункт Описание
Print 2 pictures  
on a page

Печать двух снимков на одном листе 
бумаги.

Print 4 pictures  
on a page

Печать четырех снимков на одном листе 
бумаги.

Print 8 pictures  
on a page

Печать восьми снимков на одном листе 
бумаги.

2 Выберите направление бумаги.

3 Выберите информацию и другие 
пункты для печати.
[Show date]: �Печатается дата записи. 

Если для снимка записаны количество дней 
путешествия или возраст в месяцах/годах, 
они также печатаются.

[Show title information]: �Печатается информация о 
заголовке.

[Show Face Recog. name]: �Печатается имя, 
зарегистрированное для 
функции распознавания лиц.

[Frame]: �Вокруг снимка помещается рамка.
Щелкните  для изменения цвета рамки.

4 Щелкните [Print start].
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Печать нескольких миниатюр на одном листе бумаги

1 Выберите индексную печать из 
[Printing Type:] в окне печати.

Пункт Описание
Index printing 
(large 
thumbnail)

Печать примерно 20 миниатюр на одном листе 
бумаги

Index printing 
(medium 
thumbnail)

Печать примерно 40 миниатюр на одном листе 
бумаги

Index printing 
(small 
thumbnail)

Печать примерно 80 миниатюр на одном листе 
бумаги

Index printing 
(Adjust 
to paper)

Настройка по размеру бумаги и печать до 
примерно 160 миниатюр на одном листе 
бумаги.

2 Выберите направление бумаги.

3 Выберите информацию и другие 
пункты для печати.
[Title:]: �Печать введенного заголовка в верхней части 

листа бумаги.
[Display of number of pages]: �Печать номера страницы в 

нижней части листа бумаги.
[Display of picture name:]: �Выбор информации для печати 

под миниатюрой.

4 Щелкните [Print start].
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Печать информации о файле или информации о камере рядом со снимками

1 Выберите печать информации из 
[Printing Type:] в окне печати.

Пункт Описание
Print file 
information

Печать информации, например, названия 
файла и размера снимка.

Print camera 
information

Печать записанной информации.

2 Выберите направление бумаги.

3 Выберите информацию и другие 
пункты для печати.
[Title:]: �Печать введенного заголовка в верхней части 

листа бумаги.
[Display of number of pages]: �Печать номера страницы в 

нижней части листа бумаги.

4 Щелкните [Print start].
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Печать записанных снимков в Простом режиме

1 Выберите [Simple Print] из [Printing 
Type:] в окне печати.

2 Выберите направление бумаги.

3 Выберите информацию и другие 
пункты для печати.
[Show date]: �Печатается дата записи.

Если для снимка записаны количество дней 
путешествия или возраст в месяцах/годах, 
они также печатаются.

[Show title information]: �Печатается информация о 
заголовке.

[Show Face Recog. name]: �Печатается имя, 
зарегистрированное для 
функции распознавания лиц.

4 Щелкните [Print start].Советы
●●Снимки располагаются на бумаге в соответствии с установкой 
режима снимка, указанной во время записи. 
Размер отпечатков снимков приведен ниже.
Установка режима снимка Размер печати 
4˝×6˝/10×15cm Размер L (89 × 127 мм)
E-MAIL Размер A7 (70 × 93 мм)
ENLARGE Размер, подогнанный к размеру бумаги.

Снимки, записанные в различных режимах, не распечатываются 
на одном и том же листе бумаги.
При печати снимков, записанных в режиме, отличном от режима 
Простой реж., данные снимки распечатываются в размере, 
подогнанном к размеру бумаги.
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Настройки печати (настройки DPOF)
Вы можете выполнить такие настройки, как количество отпечатанных экземпляров для неподвижных изображений (в формате JPEG 
или TIFF) на карте памяти, которые были записаны на цифровой камере.
Карту памяти, на которой имеются снимки с настройками печати, можно затем использовать с принтером или другим устройством, 
поддерживающим DPOF.

Подготовка:
Подсоедините Ваше устройство, например, устройство для 
считывания/записи карт памяти SD, в которое установлена карта 
памяти.

1 Выберите [Output] → [Print Set[DPOF]] 
из меню.

2 Выберите накопитель (карту памяти) и 
щелкните [Next].

3 Выберите изображение, отметив его, и 
щелкните [Execute].

4 Выберите снимок.

5 Установите количества экземпляров 
печати.
A : Печатать.
B : �Доступный диапазон для количества экземпляров 

печати составляет от 0 до 999. 
(При установке на 0 печать не выполняется.)

C : Не печатать.
D : Печать даты записи.
E : �Общее количество снимков, установленных для печати.
Щелкните [Apply All] для применения одинаковых настроек 
ко всем выбранным снимкам.

6 Щелкните [OK].

7 Щелкните [Close].

Советы
●●При смене на ПК имени файла снимка и пр. установка печати для 
снимка становится невозможной.
●●Установка печати для снимков с карт памяти, не 
поддерживающих DPOF, невозможна.
●●Содержание установки печати можно сохранить как [AUTPRINT.
MRK] в папке [MISC] на карте памяти.

A B

E

C
D
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Отправление по электронной почте

1 Щелкните  [Send e-mail].
Отображается экран [Send e-mail].

●●Вы также можете отобразить ее, выбрав [Output] → [Send 
e-mail] из меню.

2 Выберите изображение, отметив его, и 
щелкните [Execute].
Вы можете одновременно прикрепить до 20 снимков.

3 Выберите, отправлять ли 
изображений
без изменения или же сначала 
изменить размер или преобразовать 
формат файла.

	Для отправления снимка без изменений
Проверьте размер и затем щелкните [Send]:  
Перейдите к пункту 5.
	Для преобразования снимка
Щелкните [User settings]: Перейдите к пункту 4.

Вы можете прикрепить снимки к электронным письмам.
Вы можете также преобразовать снимок до указанного размера перед его отправлением.
К электронным письмам могут быть прикреплены снимки в форматах BMP, JPEG, TIFF и MOV.

Советы
●●В зависимости от установки электронной почты невозможно 
отправлять изображения большого размера. В таких случаях 
измените размер изображения или преобразуйте формат файла 
перед отправлением.
●●При выполнении группового показа неподвижных изображений, 
записанных в режиме серии, первое неподвижное изображение 
в группе или неподвижное изображение, установленное как 
избранное, которое находится ближе всего к началу группы, 
прикрепляется к сообщению электронной почты.
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4 Обработайте снимок.
●●Движущиеся изображения обрабатывать невозможно.

1 Преобразуйте пункты, например, формат или 
размер данных изображения.

	Преобразование снимка
A : Укажите размер снимка.
B : Введите ширину снимка.
C : Введите высоту снимка.
D : Зафиксируйте соотношение сторон снимка.
E : �Укажите размер снимка с помощью коэффициента 

увеличения или коэффициента уменьшения.
F : �Доступный диапазон для коэффициента 

увеличения и коэффициента уменьшения 
составляет от 1 % до 200 %.

	Преобразование файла
G : Для формата JPEG укажите размер файла для снимка.
H : Выберите формат данных снимка.

2 Щелкните [Preview] для проверки того, как будет 
выглядеть снимок после преобразования.

3 Щелкните   для преобразования других 
снимков.
Щелкните [Applies to all files] для одновременной обработки 
всех снимков.

4 Щелкните [OK].
Возврат к окну в пункте 3.

5 Отправьте по электронной почте
Отображается новое окно электронной почты с 
прикрепленным файлом снимка.
Введите адрес, заголовок и сообщение и отправьте 
электронное письмо.

6 Щелкните [Close].

A
B

D
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Советы
●●Для программного обеспечения электронной почты, 
отличающегося от Windows Mail, Microsoft Outlook, Microsoft 
Outlook Express и Windows Live Mail, прикрепление снимков 
к электронным письмам с помощью этой функции может не 
работать. 
●●Программа Windows Live Mail должна быть загружена с веб-сайта 
Microsoft и установлена.
●●Рекомендуется ограничивать общий размер файла электронного 
письма (размер файла текстового сообщения плюс 
прикрепленные снимки) 1 Мб.
●●Также прочитайте руководство по эксплуатации программного 
обеспечения электронной почты.

	�Установки программного обеспечения электронной 
почты 
Если Вы не можете прикрепить снимок к электронному 
письму, выйдите из PHOTOfunSTUDIO, а затем установите 
программное обеспечение электронной почты.
1 Запустите программное обеспечение электронной 

почты.
●●Если Вы запускаете ее впервые, установите адреса 
электронной почты и т.д.

2 Если появляется сообщение [Would you like to make it 
your default client?], Выберите [Yes].
Если данное сообщение не появляется, обратитесь к 
инструкциям пользователя программного обеспечения 
электронной почты для установки данной программного 
обеспечения в качестве программы, используемой по 
умолчанию.*

●●Содержание сообщения могут различаться в зависимости от 
программного обеспечения электронной почты, которым Вы 
пользуетесь.

*	Пример установки:
Для Windows 7 или Windows Vista
1 Выберите [Start] → [Control Panel] и откройте [Internet 

Options].
2 Выберите [Set programs] в ярлыке [Programs] и 

откройте [Set your default programs].
3 Выберите программное обеспечение электронной 

почты и щелкните [Set this program as default].
4 Щелкните [OK].

Для Windows XP
1 Выберите [Start] → [Control Panel] и откройте [Internet 

Options].
2 Откройте ярлык [Programs] и выберите программное 

обеспечение электронной почты в [E-mail].
3 Щелкните [OK].
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Копирование снимков на карту памяти
Неподвижные изображения и движущиеся изображения MOV, которые были сохранены на ПК (жесткий диск), можно скопировать на 
карту памяти.
Вы можете воспроизводить эти скопированные снимки на цифровой камере.

1 Щелкните  [Copy to media].
Отображается экран [Copy to media].

2 Выберите тип изображения, которое 
Вы хотите скопировать.
[Still Picture]:	Скопируйте неподвижные изображения.
[Motion JPEG video]:

										�Скопируйте движущиеся изображения MOV.

3 Щелкните [Next].

4 Подсоедините устройство, например, 
устройство для считывания/записи 
карт памяти SD, в которое установлена 
карта памяти.

●●Если носитель не отображается, щелкните [Refresh].

Советы
●●О копировании движущихся изображений AVCHD/AVCHD Lite или 
MPEG2 (→114)
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5 Выберите накопитель (карту памяти).

6 Щелкните [Next].

7 Выберите снимок, отметив его.
Проверьте общий размер данных выбранных снимков и 
свободное пространство, доступное на карте.

8 Щелкните [Execute].

Необходимое 
пространство

Доступное  
пространство
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Советы
●●Используйте карту памяти с достаточным свободным местом. 
При недостаточном свободном месте будет записано только 
половина снимков.
●●Скопированные изображения невозможно воспроизводить на 
некоторых цифровых камерах.

9 При отображении подтверждающего 
сообщения щелкните [Yes].
Снимки копируются.

10 Щелкните [Close].
●●Щелкните по [Confirm] для отображения снимков на карте 
памяти.

11 При отображении подтверждающего 
сообщения о завершении [Copy to 
media] щелкните [Yes].

	�Папка сохранения, формат сохранения и имя файла
Место сохранения снимка и имя файла будут показаны 
ниже.*

P1000001.JPG
P1000002.JPG
P1000003.JPG

.

.

.

*	�В зависимости от используемой модели буквенные 
символы названий папок могут отличаться от показанных 
на картинке.
●●Данные в формате BMP преобразуются в снимки JPEG с 
информацией Exif.
●●Связанные файлы также копируются одновременно. Если 
копировалось движущееся изображение MOV, создается 
снимок JPEG с таким же именем файла.
●●Если имеются несколько папок для сохранения, снимки 
будут сохраняться в папке с наибольшим номером.
●●Если папка сохранения отсутствует, автоматически 
создается папка [100_PANA].
●●Цифры, стоящие после последнего номера в папке, 
присваиваются файлам.
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Запись снимков на CD или на DVD

Подготовка:
Проверьте установки записывающего накопителя.

1 Откройте [Properties] для накопителя.
2 Выберите панель [Recording].
3 Установите следующим образом.

Для Windows 7:�Выберите правильный записывающий 
накопитель.

Для Windows Vista: �Выберите правильный записывающий 
накопитель.

Для Windows XP: Разрешите запись на CD.
●●При использовании привода Panasonic DVD MULTI с 
Windows XP, отобразится сообщение, подтверждающее 
запись данных на DVD-RAM диск. Чтобы записать данные 
на CD-R/RW диск, выберите команду [No], включающую 
функцию записи на CD.

1 Щелкните  [Copy to media].
Отображается экран [Copy to media].

2 Выберите тип изображения, которое 
Вы хотите скопировать.
[Still Picture]:	Скопируйте неподвижные изображения.
[Motion JPEG video]:

										�Скопируйте движущиеся изображения MOV.
●●О копировании движущихся изображений AVCHD/AVCHD 
Lite или MPEG2 (→114)

3 Щелкните [Next].

Важно
●●Типы дисков, на которых снимки могут записываться 
с использованием программного обеспечения, могут 
варьироваться в зависимости от версии Windows:

Версия Windows CD-R/RW DVD-R/RW
Windows XP –

Windows Vista/ Windows 7
: Перезаписываемый    –: Не перезаписываемый

Если на Вашем ПК есть накопитель, способный выполнять запись на CD или DVD, то Вы сможете копировать неподвижные 
изображения и движущиеся изображения MOV на CD-R/RW или DVD-R/RW.
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4 Вставьте в накопитель диск, на 
который Вы хотите записывать.

●●Если носитель не отображается, щелкните [Refresh].

5 Выберите записывающий накопитель.

6 Щелкните [Next].

7 Выберите снимок, отметив его.
Проверьте общий размер данных выбранных снимков и 
свободное пространство, доступное на диске.

8 Щелкните [Next].
Запускается стандартная программа-мастер записи 
Windows.

9 Введите заголовок диска.
●●Для Windows 7 и Windows Vista можно также установить 
скорость записи.

10 Щелкните [Next].
Начинается запись диска.
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11 Щелкните [Finish].
Отображение вернется к экрану [Copy to media].

●●Вы также можете следовать указаниям инструкции 
программы-мастера для записи одинаковых снимков на 
другой диск.

12 Щелкните [Cancel].

13 При отображении подтверждающего 
сообщения о завершении [Copy to 
media] щелкните [Yes].

Советы
●●Если в Windows Explorer имеются файлы, готовые к записи на 
диск, отображается подтверждающее сообщение. 
Если копирование на CD/DVD осуществлено, такие файлы, 
готовые к записи, отменяются.
●●Для копирования изображений на DVD-RAM или диск, 
отформатированный в Windows 7 или Windows Vista Live File 
System, сначала выйдите из этого программного обеспечения и 
затем выполните с помощью Windows Explorer.
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Использование снимков

Загрузка движущегося изображения на YouTube
Можно легко загружать движущиеся изображения, сохраненные на ПК, на YouTube.

●●Функционирование в будущем не гарантируется в случае изменения услуг или технических характеристик YouTube. Пожалуйста, 
примите во внимание, что содержание услуги или окна могут изменяться в любое время без предварительного уведомления.  
(Эта услуга доступна по состоянию на 1 мая 2010 г.)
●●Не загружайте видеозаписи, защищенные авторскими правами, за исключением случаев, когда Вы являетесь владельцем авторских 
прав или имеете разрешение, полученное от соответствующего владельца авторских прав.

Подготовка:
●●Подсоедините ПК к Интернету.
●●Заранее зарегистрируйте учетную запись на YouTube, чтобы 
получить имя пользователя и пароль.

1 Щелкните  [Network] и затем 
выберите [Upload to YouTube].
Отображается экран [Upload to YouTube].

●●Вы также можете отобразить ее, выбрав [Output] → [Network] 
→ [Upload to YouTube] из меню.

2 Выберите движущееся изображение, 
отметив его, и щелкните [Execute].
Одновременно можно загружать максимум до 10 
движущихся изображений.
Отображается [YouTube Uploader].

3 Введите [User name] и [Password] для 
YouTube.

●●Начиная со второго раза, имя пользователя запоминается.

Советы
●●Невозможно загружать неподвижные изображения со звуком.



106

Загрузка движущегося изображения на YouTube
Использование снимков

Отображается окно установок 
брандмауэра.

●●Установите установки прокси 
(сервера) для Вашего интернет-
браузера (например, Internet 
Explorer) или обратитесь к Вашему 
интернет-провайдеру относительно 
способа установки. 

4 Выберите движущееся изображение.
Выбранное движущееся изображение становится целевым 
для загрузки.

5 Введите информацию для показа на 
YouTube, например, заголовок каждого 
движущегося изображения.
A : �Выберите движущееся изображение, информацию 

которого Вы хотите редактировать.
B : Введите заголовок.
C : Введите содержание движущегося изображения.
D : Введите категорию движущегося изображения.
E : Введите ключевые слова.
F : Установите, делать ли его общедоступным.
G : �Вы можете скопировать такое же содержание на другие 

движущиеся изображения.
H :  �Установите качество загружаемого изображения для 

движущегося изображения AVCHD / AVCHD Lite.

6 Проверьте информацию о файле.
Можно загружать движущиеся изображения 
длительностью до 10 минут.

	�Редактирование движущихся изображений 
AVCHD/AVCHD Lite или MPEG2
Если Вы щелкните [Delete partially], Вы сможете удалить 
ненужные участки для сокращения движущегося 
изображения. (→109)

●●Результаты редактирования сохраняться не будут.

7 Щелкните [Upload].

A B
C

D
E

F
G

H
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Загрузка движущегося изображения на YouTube
Использование снимков

8 При показе подтверждающего 
сообщения относительно защиты 
авторских прав содержания проверьте 
содержание, установите метку и 
щелкните [OK].
Загружается движущееся изображение.

9 Щелкните [OK].

10 Щелкните [Close].

11 Щелкните [Close].
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Получение неподвижных изображений из движущихся изображений

Редактирование движущихся изображений

Вы можете выделить кадр из воспроизводящегося движущегося изображения и сохранить его в качестве неподвижного изображения 
в формате JPEG с информацией Exif.

1 В окне просмотра выполните паузу 
движущегося изображения в месте, 
в котором Вы хотите получить 
неподвижное изображение.

●●Вы можете также отобразить окно воспроизведения, выбрав 
[Edit] → [Edit movie] → [Capture] из меню.

2 Щелкните .

3 Выберите папку назначения для 
сохранения.

	Для сохранения в папке, которая не показана
1 Щелкните [Browse save destination folders].
2 Выберите нужную Вам папку или создайте новую 

папку и затем щелкните [OK].

4 Введите имя файла.

5 Щелкнит [OK].
Сохраняется неподвижное изображение с таким же 
размером, как и движущееся изображение.
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Удаление части движущегося изображения 

Редактирование движущихся изображений AVCHD/AVCHD Lite или MPEG2/копирование на носитель

Вы можете удалять ошибочные или ненужные участки движущихся изображений AVCHD/AVCHD Lite или MPEG2, которые были 
скопированы на ПК.

●●Частичное удаление невозможно выполнить для движущихся изображений длительностью меньше 2 секунд.

1 Щелкните  [Edit movie] и затем 
выберите [Delete partially].
Отображается экран [Delete partially].

●●Вы можете также отобразить ее, Выбрав [Edit] → [Edit movie] 
→ [Delete partially] из меню.

2 Выберите одно движущееся 
изображение и щелкните [Execute].
Отображается экран [Delete partially].

Выбранное поле
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Удаление части движущегося изображения 
Редактирование движущихся изображений AVCHD/AVCHD Lite или MPEG2/копирование на носитель

3 Щелкните  для начала 
воспроизведения движущегося 
изображения и щелкните  для 
паузы в позиции начала удаления.

●●Вы можете выбрать позицию воспроизведения, перемещая 
регулятор.

	Точные настройки позиции
 : Кадр назад/кадр вперед 
 : Пропуск вперед или назад примерно по 0,5 сек.

4 Щелкните [Set start point] для 
определения начальной точки.

●●Вы можете также определить начальную точку, перетащив 
 на регуляторе.

5 Щелкните  для повторного начала 
воспроизведения и щелкните  для 
паузы в позиции окончания удаления.

6 Щелкните [Set end point] для 
определения конечной точки.

●●Вы можете также определить конечную точку, перетащив  
на регуляторе.

7 Щелкните [Select] для подтверждения 
диапазона.
Отображаются миниатюры в начальной и конечной точках, 
а диапазон для удаления показан серым.
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Удаление части движущегося изображения 
Редактирование движущихся изображений AVCHD/AVCHD Lite или MPEG2/копирование на носитель

●●Если Вы хотите выбрать несколько диапазонов, повторите 
действия пунктов с 3 по 7.
●●Для отмены выбранного диапазона выберите 
соответствующую миниатюру и щелкните [Release].
A : �После этого останется миниатюра, представляющая 

диапазон.
B : �После этого будет удалена миниатюра, 

представляющая диапазон.

8 Щелкните [Start preview] для проверки 
результатов редактирования.

●●Вы можете отменить воспроизведение, щелкнув по [Stop 
Preview].

9 Щелкните [Partially delete].
Движущееся изображение после редактирования будет 
заново создано и сохранено в той же папке, что и 
исходное движущееся изображение.

●●  добавится к миниатюре созданного движущегося 
изображения.
●●Для обработки требуется много времени. Не работайте на 
ПК, пока операция не будет закончена.

10 Щелкните [Close].

Советы
●●Для движущихся изображений AVCHD (технические характеристики 
NTSC) с размером изображения 1920x1080, которые были 
записаны с помощью цифровой камеры, отличающейся от той, с 
которой поставляется данное программное обеспечение, поскольку 
редактирование выполняется по 15-кадровым элементам, позиция 
удаления может немного сместиться. Кроме того покадровое 
воспроизведение в обратном/прямом направлении невозможно 
выполнять в окне [Delete partially].

Регулятор 
C D

E
F

C : Начальная точка удаления.
D : Текущая позиция воспроизведения.
E : Конечная точка удаления.
F : Диапазон удаления.

A B
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Редактирование движущихся изображений AVCHD/AVCHD Lite или MPEG2/копирование на носитель

Преобразование движущихся изображений AVCHD/AVCHD Lite к формату MPEG2
Движущиеся изображения AVCHD/AVCHD Lite можно преобразовать к формату MPEG2

1 Выберите  [Edit movie]→[Convert 
MPEG2] из меню.
Отображается экран [Convert MPEG2].

●●Вы можете также отобразить ее, выбрав [Edit] → [Edit 
movie]→[Convert MPEG2] из меню.

2 Добавьте метку к изображению, чтобы 
выбрать его, и щелкните [Next].

3 Выберите установки сохранения.
	Папка назначения для сохранения

A : Сохраните в той же папке, что и исходный снимок.
B : �Сохраните в другой папке. Щелкните [Browse] и 

выберите назначение для сохранения.

4 Щелкните [Execute].

5 При отображении подтверждающего 
сообщения щелкните [Yes].
Формат данных снимка изменяется.

6 Щелкните [OK].

7 Щелкните [Close].Советы
●●Преобразование движущихся изображений может занять 
несколько часов.

A
B
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Редактирование движущихся изображений AVCHD/AVCHD Lite или MPEG2/копирование на носитель

Запись на карту памяти или DVD (формат AVCHD/формат DVD-Video)
В данном разделе описаны способы записи движущихся изображений AVCHD/AVCHD Lite или MPEG2, сохраненных на ПК, на карту памяти или на DVD.
Важно
●●Карты памяти или DVD стандарта AVCHD, созданные с помощью этого ПО, могут воспроизводиться только на устройствах воспроизведения, 
совместимых со стандартами AVCHD. (Невозможно их воспроизведение на обычных DVD-плеерах, несовместимых со стандартом AVCHD.) 
Не вставляйте диски в несовместимые устройства, так как может быть невозможно извлечь диски или устройство может удалить данные на 
диске после отображения сообщения с предложением форматирования диска. 
Кроме того, поскольку файловая система использует формат UDF 2.5, файлы на диске невозможно проверить на ПК с помощью Windows 
Explorer, если только не установлена система UDF 2.5.
●●Для двухслойных или односторонних DVD-R в зависимости от проигрывателя движущиеся изображения могут ненадолго 
приостанавливаться или же может быть неслышно звук в момент переключения с первого на второй слой.
●●Не удаляйте, не изменяйте и не перемещайте папки на дисках или файлы в папках. Данные могут не воспроизводиться.
●●Верхнее меню может отображаться только на устройствах воспроизведения, способных показывать верхнее меню.

Применимая карта памяти / DVD (носитель)

Формат записи Качество 
изображения Пригодный для записи носитель Верхнее 

меню
Добавление на носитель с 
предыдущими записями*1

Устройство 
воспроизведения

Формат AVCHD Высокая 
четкость

Карта памяти*2 невозможно 
создать Возможно

Устройства, 
совместимые со 
стандартом AVCHD 

DVD-RAM (12 см односторонний/
двухсторонний)*3 Можно создать Возможно*4

Устройства, 
совместимые со 
стандартом AVCHD 

DVD-R (12 см односторонний/двухсторонний/
двухслойный на одной стороне)
DVD-RW (12 см односторонний/двухсторонний)

Можно создать Невозможно
Устройства, 
совместимые со 
стандартом AVCHD 

Формат  
DVD-Video 

Стандартное 
качество

DVD-R (12 см односторонний/двухсторонний/
двухслойный на одной стороне)
DVD-RW (12 см односторонний/двухсторонний)

Можно создать Невозможно Обычный DVD 
проигрыватель

*1	Только при добавлении к носителю, на который была выполнена запись в стандартах AVCHD.
*2	�Для карты памяти SDHC (от 4 ГБ до 32 ГБ) или карты памяти SDXC (от 48 ГБ до 2 ТБ) потребуется устройство, поддерживающее 

соответствующую карту памяти.
*3	Невозможно использовать DVD-RAM емкостью 2,6 Гб и 5,2 Гб двустороннего типа.
*4	�Добавление невозможно, если установлена защита. Удалите установки с помощью устройства, использовавшегося для установки 

защиты, или включите установки автоматической защиты (→124).
Советы
●●Это программное обеспечение невозможно использовать для записи дисков Blu-ray.
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Запись на карту памяти или DVD (формат AVCHD/формат DVD-Video)
Редактирование движущихся изображений AVCHD/AVCHD Lite или MPEG2/копирование на носитель

Копирование на носитель
Важно
●●Выполнение некоторых действий во время записи данных на диск могут привести к неправильной записи, а также к повреждению диска, 
устройства или данных. Ниже приводятся такие операции.
- Операции по переключению пользователя или выходу из Windows.
- Работа с другими ПО, относящимися к записи данных.
- �Установка или извлечение соединительных кабелей ПК или устройства DVD (внешний привод DVD), включение или выключение питания.
- Другие устройства USB, например, устройство для считывания карт памяти SD, подсоединяются или отсоединяются.
- Принудительное закрытие этого ПО.

1 Щелкните  [Copy to media].
Отображается экран [Copy to media].

2 Выберите опцию [AVCHD/AVCHD Lite 
video] или [MPEG2 video].

●●Подробные сведения о копировании неподвижных 
изображений и движущихся изображений MOV: (→99, 102)
●●При записи на DVD проверьте тип носителя.

3 Щелкните [Next].

4 Установите носитель.
Подсоедините устройство, например, устройство для 
считывания/записи карт памяти SD, в которое установлена 
карта памяти, или вставьте в накопитель диск, на который 
Вы хотите выполнить запись.

●●Если носитель не отображается, щелкните [Refresh].Советы
●●  Движущиеся изображения MPEG2 невозможно записывать на 
карты памяти SD.
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Запись на карту памяти или DVD (формат AVCHD/формат DVD-Video)
Редактирование движущихся изображений AVCHD/AVCHD Lite или MPEG2/копирование на носитель

5 Выберите пишущий накопитель или 
карту памяти.

6 Щелкните [Next].

7 Выберите установки копирования.
	Способ копирования (только при записи на DVD)

A : �Копирование с высокой четкостью.
(Движущиеся изображения MPEG2 невозможно 
копировать в формате AVCHD)

B : �Копирования со стандартным качеством в формате, 
который может воспроизводиться на обычных 
проигрывателях DVD.

	Порядок снимков для копирования
C : �Копирование в порядке даты записи. Если Вы 

копируете с этой установкой, несколько движущихся 
изображений, записанных в один и тот же день в 
одинаковом режиме, объединяются вместе.

D : �Вы можете выбрать порядок воспроизведения.

8 Щелкните [Next].

9 Выберите снимок, отметив его.
Проверьте общий размер данных выбранных снимков и 
свободное пространство, доступное на диске.

A
B

C
D
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Запись на карту памяти или DVD (формат AVCHD/формат DVD-Video)
Редактирование движущихся изображений AVCHD/AVCHD Lite или MPEG2/копирование на носитель

10 Щелкните [Next].
Отображается окно создания верхнего меню.

	При добавлении на карту памяти или DVD-RAM
Если установлена карта памяти или DVD-RAM, уже 
содержащие записи в стандарте AVCHD, появится 
подтверждающее сообщение о добавлении данных. 
Выберите [Yes].

 или  отображается на движущихся изображениях, 
которые уже были записаны.

●●Если Вы не хотите добавлять данные, извлеките или 
отформатируйте носитель.

11 Установите фон и компоновку 
верхнего меню.

●●Верхнее меню невозможно создать при записи на карту 
памяти. Перейдите к пункту 13.

1 Проверьте назначение для записи.
2 Проверьте размер данных, чтобы удостовериться в 

том, что они поместятся на карту памяти или DVD.
3 Выберите качество изображения при записи (только 

DVD-Video).
4 Выберите фон и компоновку.

A : �Вы можете выбрать дизайн фона.
Если Вы выберите [User’s picture], неподвижное 
изображение (формата JPEG) на ПК можно 
использовать для фона.

B : �Вы можете выбрать компоновку изображения.
Если выбрано [No menu], Вы не сможете установить 
дизайн фона или заголовок.

A

B
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Запись на карту памяти или DVD (формат AVCHD/формат DVD-Video)
Редактирование движущихся изображений AVCHD/AVCHD Lite или MPEG2/копирование на носитель

12 Установите заголовок.
1 Введите заголовок страницы и заголовок 

изображения.
2 Щелкните [Font/Title].
3 Выберите установки символов для заголовка диска.

[Font]: Установите тип символов.
[Size]: Установите размер символов.
[Style]: Установите стиль символов.

: Символы будут в полужирном шрифте.
: Символы будут в курсивном шрифте.
: Будет добавлено подчеркивание.
: Будет добавлено затенение.

[Colour]: Установите цвет символов.
[Shading]: При выборе  в [Style] установите цвет затенения.
[Align]: Установите компоновку символов.

4 Таким же способом установите заголовок видео.

13 Щелкните [Start copying].
	Если защита не установлена
Если невозможно установить защиту диска с помощью 
накопителя, отображается подтверждающее сообщение.
Щелкните [Yes] для начала копирования.

●●Созданный диск может неправильно распознаваться 
другими устройствами воспроизведения.
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14 При отображении подтверждающего 
сообщения щелкните [Yes].
Отображается состояние выполнения записи.

●●Щелчок по [Cancel] отменит запись. 
Однако для DVD-R/RW запись можно отменить только 
во время преобразования данных. Невозможно отменить 
запись во время ввода данных.

15 При отображении подтверждающего 
сообщения о завершении записи 
щелкните [OK].
Отображение вернется к экрану [Copy to media].

●●При отображении подтверждающего сообщения с запросом 
о продолжении и записи на другой носитель щелкните [Yes] 
или [No].
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Советы
●●Для записи всех данных потребуется время. Не работайте на ПК, 
пока запись не завершится.
●●Невозможна запись движущихся изображений 
продолжительностью менее одной секунды или движущихся 
изображений без звука.
●●При воспроизведении записанного диска между движущимися 
изображениями возможно прерывание воспроизведения.
●●Если сбой записи обусловлен проблемой с носителем, повторно 
установите носитель, согласно сообщению с подсказкой. Часть 
данных, при обработке которых произошел сбой, будет записана 
по новой на новый носитель.
●●На дисках DVD-R с двумя слоями на одной стороне возможно 
застывание движущихся изображений или частичное 
исчезновение звука в моменты, когда происходит переключение с 
первого слоя на второй. Это зависит от плеера.

16 Щелкните [Close].
●●Щелкните по [Confirm] для отображения снимков на 
носителе.

17 При отображении подтверждающего 
сообщения о завершении [Copy to 
media] щелкните [Yes].

●●При записи в формате DVD-Video
- �Может занять несколько часов вследствие необходимости 

преобразования движущихся изображений в формат MPEG2.
- �В связи с необходимостью записи не менее 1 Гб данных 

в DVD-R/RW, обусловленных стандартом, если объем 
создаваемых данных будет менее 1 Гб, будут добавлены 
фиктивные данные так, чтобы в целом объем достиг 1 Гб. 

- �Если движущееся изображение содержит участки с быстрым 
движением, при преобразовании движущегося изображения 
очертания могут утратить резкость или же могут иметь 
место помехи. Качество может улучшиться при выборе 
[Picture quality priority] в качестве установки качества снимка 
для преобразования в установках функции движущегося 
изображения. (→123)
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Форматирование диска
Форматирование диска DVD необходимо в следующих случаях.
- Когда DVD-RAM, предназначенный для записи данных, не отформатирован в формате UDF 2.5 или он новый.
- �Для записи данных на бывший в использовании DVD-RAM/RW. 

(Тем не менее, возможна дополнительная запись данных на DVD-RAM в случаях, если содержание уже записано в стандарте 
AVCHD.)

Важно
●●Форматирование удалит все существующие данные на диске. Поскольку отмена процесса форматирования невозможна, будьте осторожны 
и проверьте содержание диска.
●●При записи данных согласно стандарту AVCHD на диски DVD с помощью этого ПО диск должен форматироваться этим ПО. Поставляемый 
вместе с приводом DVD инструмент форматирования может не поддерживать стандарт AVCHD.
●●Если Вы не можете отформатировать диск, измените установку авто защиты на включенное состояние или отмените установку на 
устройстве, с помощью которого была установлена защита. (Включенная настройка автоматической защиты диска будет сброшена после 
форматирования.)

1 Щелкните [Initialize] в окне выбора 
для накопителя места назначения для 
копирования (→115).
Отображается экран [Disc initializing tool].

●●Вы также можете отобразить, щелкнув по [Initialize] в окне 
создания верхнего меню (→116).
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2 Установите содержание форматирования.
1 Проверьте привод.

После замены диска или отсоединения накопителя 
щелкните [Refresh].

2 Выберите тип форматирования.
[Blank]: Выберите при форматировании DVD-RW.
[Universal disk format (UDF 2.50)]: 

Выберите при записи на DVD-RAM в формате AVCHD.
3 Выберите вариант.

[Simple erasure]: �Логическое форматирование 
выполняется за короткий промежуток 
времени (около 1 минуты). Если данные 
уже записаны на диск, будет удалена 
только информация в списке содержания.

[Complete erasure]: �Будет выполнено физическое 
форматирование диска. В зависимости от 
скорости привода и диска процесс может 
занять долгое время. Все записанные до 
этого данные будут удалены с диска.

3 Щелкните [Start].

4 При отображении подтверждающего 
сообщения щелкните [Yes].

●●Появляется сообщение о том, что полное стирание потребует 
длительного времени.

5 При отображении подтверждающего 
сообщения о завершении 
форматирования щелкните [OK].

Советы
●●Не поддерживается форматирование в формате UDF 2.0. 
Предназначенный к использованию в обычном DVD-рекордере 
диск должен быть отформатирован в формат UDF 2.0 с помощью 
инструмента форматирования на приводе DVD. (Для получения 
дополнительной информации о методах работы обратитесь к 
инструкции привода.)
●●Карты памяти должны форматироваться с помощью цифровой 
камеры, поддерживающей это ПО.
●●Форматироваться могут только диски, пригодные для 
использования с этим ПО. (Тем не менее, форматирование 
DVD-R невозможно.)
●●В двухсторонних дисках форматируется сначала одна сторона, 
потом другая.
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Функции установок движущихся изображений
Вы можете выбрать установки, относящиеся к функциям для воспроизведения движущихся изображений и для записи на диски или 
другие носители.

1 Выберите [Tools] → [Settings] из меню.

2 Измените установки воспроизведения 
движущихся изображений.
1 Установите способ воспроизведения движущегося 

изображения и установки воспроизведения AVCHD/
AVCHD Lite.

	Способ воспроизведения
[File unit]: �Воспроизведение отображаемого 

движущегося изображения до конца и его 
остановка.

[Repeat playback]: �Повторное воспроизведение 
одного движущегося 
изображения.

[Continuous playback]: �Непрерывное воспроизведение 
всех движущихся изображений, 
показанных в виде миниатюр.

	Установки воспроизведения AVCHD/AVCHD Lite
[Play with optimum speed]:
					�Воспроизведение со скоростью, подходящей для 

работы ЦПУ ПК.
[Specify number of frames]: 
					�Если качество воспроизведения не очень 

хорошее, выбирается небольшое количество 
кадров.  
Это можно улучшить. 
Кадры могут пропускаться или воспроизведение 
может стать менее плавным в случае, если 
выбрана более высокая скорость кадров по 
сравнению с текущей установкой.
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2 Установите качество изображения MPEG2 
	Установки обнаружения движения
[Picture quality priority]:
					�Чтобы предотвратить шум, преобразование 

будет произведено с приоритетом качества 
изображения. Преобразование может занять 
продолжительное время. Рекомендуется 
использовать эту настройку при преобразовании 
быстро движущихся изображений.

[Normal]: �Преобразованное изображение будет иметь 
стандартное качество.

[Speed priority]: �Преобразование займет минимальное 
время. Быстро движущиеся 
изображения будут сопровождаться 
значительными шумами.

3 Измените установки для копирования 
на носитель.
1 Установите рабочее поле жесткого диска и скорость 

записи диска.
	Установка рабочего поля
Рабочее поле является областью жесткого диска ПК, 
временно используемой при работе.
Выберите привод, объем свободного места 
на котором должен вдвое превышать размер 
создаваемого диска.

●●При выборе привода с файловой системой FAT32 
запись на диск DVD-Video может не удасться. 
Выберите привод файловой системы NTFS.

	Установка скорости записи диска
[Max. speed (recommend)]: 
					Запись при максимальной скорости накопителя.
[Normal]: �Выбирается при сбое записи. Это можно 

улучшить.
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2 Выберите установки для записи в формате AVCHD.
	�Установки автоматической защиты для записи 
на DVD-RAM/RW
[Auto Protect ON]: �Временное выключение установки 

защиты при добавлении данных 
на DVD в стандарте AVCHD, 
установленным в качестве 
защищенного. (Установка защиты 
снова устанавливается при 
извлечении DVD.)

[Auto Protect OFF]: �Запись на защищенный DVD 
невозможна.

4 Щелкните [Apply].
●●При выполнении щелчка по [OK] применяются установки, и 
окно закрывается.

Советы
●●Вы также можете выбрать установки для копирования на 
носитель, щелкнув [Settings] в окне создания верхнего меню (→116).
●●Диски DVD-RAM/RW, записанные с включенной автоматической 
защитой, заданы как защищенные, поэтому их форматирование 
с помощью другого ПО для записи DVD или с помощью Explorer 
будет невозможным. 
В таком случае форматирование диска с помощью этого ПО 
приведет к уничтожению установки защиты с последующим 
разрешением на форматирование диска для других ПО. 
([Complete erasure] займет продолжительное время, поэтому 
рекомендуется использование [Simple erasure].)
●●При включенной автоматической защите защита устанавливается 
после записи даже для DVD, для которых защита не установлена, 
немедленно после форматирования.
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Отображаются изображения, находящиеся на карте памяти. Невозможно отобразить изображения, хранящиеся на носителе, отличном 
от карты памяти.

1 Выберите [File] → [SD card picture 
browsing] из файла.
Отображается экран [SD card picture browsing].

2 Выберите накопитель, содержащий 
изображения, которые Вы хотите 
отобразить, и щелкните [Next].

●●Если подсоединенный накопитель или карты памяти не 
отображаются, щелкните [Refresh].

3 Выберите изображение и щелкните 
[Playback].
Воспроизводится выбранное изображение. 

●●Изображение также воспроизводится при щелчке по нему.
●●Щелкните [Copy to PC] для перехода к окну выбора для 
изображения, которое Вы хотите скопировать.

Советы
●●Если Вы щелкните [Playback] до выбора изображений, будет 
воспроизводиться первое изображение. 
Если Вы щелкните [Playback] после выбора изображений, будут 
воспроизводиться выбранные изображения.

Отображение изображений с карты памяти
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Регистрация другого программного обеспечения
В меню можно зарегистрировать до 10 программ, что позволяет Вам запускать их непосредственно с помощью этого программного 
обеспечения.

1 Выберите [Tools] → [Settings] из меню.
Отображается окно установок.

2 Щелкните [General] — [Launcher].

3 Щелкните [Add].
●●Невозможно добавлять дальнейшие программы, если уже 
зарегистрировано 10 программ. Отмените регистрацию 
каких-либо программ, которые больше не нужны.

4 Выберите исполняемый файл (.exe) для 
программного обеспечения, которое Вы 
хотите зарегистрировать, и щелкните [Open].

5 Щелкните [Apply].
Программное обеспечение регистрируется.

●●При выполнении щелчка по [OK] применяются установки, и 
окно закрывается.

Советы
●●Зарегистрируйте программное обеспечение, совместимое с 
изображениями.
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Открытие снимков с помощью зарегистрированного программного обеспечения

1 Выберите снимок.

2 Выберите зарегистрированное 
программное обеспечение в [Tools] → 
[External program] из меню.
Зарегистрированное программное обеспечение 
запускается с открыванием выбранного снимка.

Советы
●●Если для показа выбрано свыше 10 изображений, будет 
отображаться подтверждающее сообщение. При щелчке 
по [Yes] откроется максимум 10 изображений с помощью 
зарегистрированной внешней программы. Если Вы щелкнете по 
[No], приложение не будет запущено.
●●Если операция выполняется без выбора снимка, программное 
обеспечение будет просто запускаться.

Удаление зарегистрированного программного обеспечения

1 Выберите [Tools] → [Settings] из меню.
Отображается окно установок.

2 Щелкните [General] — [Launcher].

3 Выберите зарегистрированную 
программу и щелкните [Delete].
Программное обеспечение удаляется.

4 Щелкните [Apply].
●●При выполнении щелчка по [OK] применяются установки, и 
окно закрывается.
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Измените установки для копирования снимков на ПК

1 Выберите [Tools] → [Settings] из меню.

2 Щелкните [General] — [Basic].

3 Измените установки.
	Сортировка для копирования на ПК

A : �Сохранение во вложенной папке по дате 
копирования (сегодня).

B : Сохранение во вложенной папке по месяцу записи.
C : Сохранение во вложенной папке по дате записи.

	Автоматический запуск D
При установленной метке программное обеспечение 
запускается при подсоединении цифровой камеры или 
карты памяти и отображается экран [Copy to PC].

	Окно сообщения для подтверждения сброса E
Будет повторно включен экран подтверждения отмены.

4 Щелкните [Apply].
●●При выполнении щелчка по [OK] применяются установки, и 
окно закрывается.

Вы можете изменять установки для копирования снимков с цифровой камеры или карты памяти на ПК.

B

A
C

E
D
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Выполнение простого воспроизведения миниатюр движущихся изображений
Вы можете установить функцию, в которой предварительный просмотр выполняется при наведении указателя мыши на миниатюру 
движущегося изображения.

1 Выберите [Tools] → [Settings] из меню.
Отображается окно установок.

2 Щелкните [General] — [Thumbnail].

3 Установите, включать ли 
предварительный просмотр.
При установке метки для выполнения простого 
воспроизведения достаточно навести мышь на миниатюру 
движущегося изображения.

4 Щелкните [Apply].
●●При выполнении щелчка по [OK] применяются установки, и 
окно закрывается.

Советы
●●Во время простого воспроизведения звук не воспроизводится.
●●Частота кадров простого воспроизведения составляет приблиз.  
2 кадра в секунду.
●●При установке [Preview] простое воспроизведение выполняется 
даже для миниатюры, которая собирательно показывает 
несколькие изображения, например, по месяцу записи или дате 
записи в календарном отображении.
●●При включенном предварительном просмотре изображения 
могут отображаться не плавно в зависимости от эффективности 
Вашего ПК.
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Установка операции при наличии такого же имени файла
Вы можете установить операцию, если неподвижное изображение с таким же именем уже имеется в папке назначения для сохранения 
(включая вложенные папки) при копировании на ПК.

1 Выберите [Tools] → [Settings] из меню.
Отображается окно установок.

2 Щелкните [Still Picture] — [Copy to PC].

3 Установите операцию при наличии 
файлов с одинаковыми именами.
[Auto]:					�Сравниваются дата и время модификации и размер 

файла. В случае если оценивается один и тот же 
файл, он считается идентичным, вследствие чего 
снимки из него не переносятся.  
В случае, если один из них отличается от 
остальных, снимки из файла переносятся путем 
добавления цифры в скобках в конце имени файла.

[Manual]:	�Выполняется указанное действие.
														[Add number to the end of the file name]: 
																															Сохраняется с другим именем.
														[Skip]:								Не сохраняется.
														[Overwrite]:	�Перезаписывается, если файл тот же 

самый (одинаковые дата обновления, 
размер). Если файл отличается, он 
не перезаписывается и сохраняется, 
но вместо этого добавляется номер в 
скобках в конце имени файла.

4 Щелкните [Apply].
●●При выполнении щелчка по [OK] применяются установки, и 
окно закрывается.

Советы
●●При копировании файла изображения, имеющего связанный 
файл (→146), если в папке назначения для сохранения имеется 
файл с таким же именем, операция [Operation when the same file 
name exists] выполняется для обоих файлов. Однако имейте в 
виду, что для движущихся изображений AVCHD/AVCHD Lite они 
сохраняются с разными именами, если файлы с одинаковыми 
именами уже существуют.
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Удобные функции

Изменение установки информации об обновлениях

Советы
●●Установка по умолчанию обеспечивает проверку информации об 
обновлениях при каждой активизации программы. (Только при 
подсоединении ПК к Интернету).
●●Относительно процедуры обновления программного обеспечения 
обращайтесь к отображаемой странице поддержки.

1 Выберите [Tools] → [Settings] из меню.

2 Щелкните [Support] — [Application 
update].

3 Измените установку информации об 
обновлениях.
Если Вы добавите метку, информация об обновлениях 
программного обеспечения проверяется при каждой 
активизации программы. (Только при подсоединении ПК к 
Интернету).

4 Щелкните [Apply].
●●При щелчке по [OK] применяются установки, и окно 
закрывается.

Проверка информации об обновлении программного обеспечения
Автоматическая проверка информации об обновлениях

Информация об обновлениях программного обеспечения автоматически проверяется при каждой активизации программы 
PHOTOfunSTUDIO и при необходимости предоставляет Вам последние обновления.

●●Подтверждение информации об обновлении также доступно при выборе [Help] → [Check for application updates] из меню.
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Список меню

Прочее

	File
Пункт меню Описание Ссылка

Copy to PC Копирование снимка с устройства, например, с цифровой камеры или 
карты памяти, на ПК.

19

SD card picture browsing Отображение изображений на картах памяти SD. 125
Delete Удаление снимка. 31
Protect ON Защита снимков от случайного удаления. 32OFF Отмена защиты.
Favorite ON Установка выбранных изображений в качестве избранных. 34OFF Отмена избранных.
Properties Отображение информации о снимке. 41
Exit Выход из PHOTOfunSTUDIO. 18

	Edit
Пункт меню Описание Ссылка

Edit still picture Counter-clockwise Rotation Поворот неподвижного изображения на 90 градусов против часовой стрелки. 66
Clockwise Rotation Поворот неподвижного изображения на 90 градусов по часовой стрелке. 66
Resize Изменение размера снимка. 67
Retouch Изменение яркости или цветности снимка. 69
Panorama stitch  Склеивание нескольких неподвижных изображений для создания 

панорамного изображения.
73

Edit movie Capture Создание неподвижного изображения из движущегося изображения. 108
Delete partially Удаление ненужных участков из движущегося изображения AVCHD/

AVCHD Lite или MPEG2.
109

Convert MPEG2 Преобразование движущихся изображений формата Motion JPEG и 
AVCHD/AVCHD Lite к формату MPEG2.

112

	View
Пункт меню Описание Ссылка

Refresh Ручное обновление в случае отсутствия обновления отображения по 
результатам редактирования.

33

Display mode Thumbnail display Показ снимков в папке. 24
Calendar display Показ снимков по дате записи. 25
Place-name display Показ изображений по месту выполнения записи. 26
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Список меню
Прочее

	View (продолжение)
Пункт меню Описание Ссылка

Picture to display All Показ всех (соответствующих) неподвижных изображений и движущихся 
изображений.

22

Still Picture Показ только неподвижных изображений. 22
Movie Показ только движущихся изображений. 22

Sorting pictures ascending order Сортировка показа снимков в порядке возрастания. 24
descending order Сортировка показа снимков в порядке убывания. 24
Name Показ в порядке имен. 24
Recording date Показ в порядке даты записи. 24
File size Показ в порядке размера файла. 24

Expand a group containing burst pictures / 
Group burst pictures into a group

Совместная группировка или развертывание неподвижных изображений, 
записанных в режиме серии.

22

	Tools
Пункт меню Описание Ссылка

Settings Показ диалогового окна установок. 50, 122 - 128
Face Recognition Register/edit face Регистрация и изменение информации распознавания лиц и снимков лиц. 55, 60

Remove from list Удаление зарегистрированной информации о распознавании лица. 65
Start face analysis Начало анализа лиц для распознавания лица. 58
Cancel face analysis Отмена анализа лиц для распознавания лица. 58

Slide show Playback now Установка выбранных снимков в слайд-шоу для просмотра. 43
Create new/edit Создание или редактирование слайд-шоу с использованием 

необходимых установок.
44

Load Отображение сохраненного слайд-шоу. 47
Delete Удаление сохраненного слайд-шоу. 48
Convert MPEG2  Преобразование созданного слайд-шоу в формат MPEG2 49

Still picture tool Format conversion Преобразование формата снимка неподвижного изображения. 77
Batch Rename Изменение имен файлов нескольких снимков. 78
Change recording date Исправление неправильных даты и времени записи. 79
Register as wallpaper Установка снимка в качестве обоев рабочего стола. 82
Burn-in Создание неподвижных изображений, на которые записана дата записи 

или записанное имя.
83

External program Запуск зарегистрированной внешней программы. 126
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Список меню
Прочее

	Output
Пункт меню Описание Ссылка

Print Печать снимков. 86
Send e-mail Отправление снимков по электронной почте. 96
Copy to media Копирование снимков на карту памяти или CD/DVD. 99, 102, 113
Network Upload to YouTube Загрузка движущихся изображений на YouTube. 105
Print Set[DPOF] Установка информации, например, количества снимков для печати. 95

	Help
Пункт меню Описание Ссылка

Check for application updates Проверка информации об обновлениях приложения. 131
About Показ версии этого программного обеспечения. ―

	Manual
Пункт меню Описание Ссылка

Manual Показ инструкции по эксплуатации (данного руководства). ―
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Прочее

Список меню с вызовом правым щелчком
Функции, которые невозможно выполнять вследствие рабочего состояния или других причин, показаны серым и не могут быть 
выбраны.

	При правом щелчке по снимкам (или миниатюрам) 
Пункт меню Описание Ссылка

Playback Показ выбранного снимка в окне просмотра. 36
BURST PLAY Отображение выбранных изображений в окне воспроизведения по 

группе, в которую они были записаны в режиме серии.
38

Slide show Установка выбранных снимков в слайд-шоу для просмотра. 43
Cut Обрезка выбранного изображения. ―
Copy Копирование выбранного изображения. ―
Paste Вставка обрезанных или копированных изображений. ―
Change Name Изменение имени выбранного изображения. ―
Delete Удаление выбранного изображения. 31
Delete (�Когда выбор ограничен по информации 

распознавания лица)
Удаление информации о категории распознавания лиц выбранного 
снимка.

65

Protect ON Защита снимков от случайного удаления.
32

OFF Отмена защиты.
Favorite ON Установка выбранных изображений в качестве избранных.

34
OFF Отмена избранных.

Delete place-name information Удаление информации о названии места. ―
Expand a group containing burst pictures / 
Group burst pictures into a group

Совместная группировка или развертывание неподвижных изображений, 
записанных в режиме серии.

22

Properties Отображение информации о выбранном изображении. 41
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Список меню с вызовом правым щелчком
Прочее

	При правом щелчке по папкам
Пункт меню Описание Ссылка

Create folder Создание новой папки. ―
Change folder name Изменение имени папки. ―
Delete folder Удаление папки. ―
Folder face analysis Классификация снимков в папке по распознаванию лиц. 58
Refresh folders Обновление показа выбранной папки. 33
Cut Обрезка выбранной папки. ―
Copy Копирование выбранной папки. ―
Paste Вставка обрезанной или скопированной папки. ―

	При правом щелчке по списку распознавания лиц
Пункт меню Описание Ссылка

Change Name Изменение имени выбранного списка. 60
Delete category results Удаление выбранного списка. 65
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Прочее

Проблемы и их решения (В&О)
Показ

Симптом Проверка

Показ возможет в режиме миниатюр, 
но не в окне показа.

Превышен максимальный поддерживаемый размер.
Для снимков, имеющих снимки миниатюр с данными Exif, возможно только отображение 
миниатюр.

Имеются два файла с одинаковым 
именем.

Два файла, связанные друг с другом, (связанные файлы) имеют одинаковое имя, но 
разное расширение.
Если связь между файлами не восстановлена, иногда их невозможно воспроизвести на 
цифровой камере.

Даже после удаления движущегося 
изображения, которое ранее было 
сохранено, остается неподвижное 
изображение, идентичное 
движущемуся изображению.

При записи движущихся изображений MOV на цифровую камеру записываются как 
движущиеся изображения (файл MOV), так и неподвижное изображение (файл JPEG).
В случае выполнения копирования движущихся изображений с помощью 
PHOTOfunSTUDIO 3.1 или более ранней версии, неподвижные изображения с таким же 
именем (связанный файл) также были скопированы. Если Вы хотите удалить оба таких 
файла, выберите их вместе и удалите.

Невозможно отобразить нужный Вам 
снимок.

Если показ ограничен по распознаванию лиц или пункту классификации, отмените 
ограничение.
Также проверьте, установлен ли формат снимка для показа только на неподвижные 
изображения или только на движущиеся изображения.

Отображается ошибочная миниатюра.

Если миниатюра со значком [Error] остается даже после выбора [View] → [Refresh] в 
меню, возможна одна из следующих причин:

●●Файл изображения не существует 
Файл мог быть перемещен или удален с помощью другой программы. Щелчок по 
миниатюре с индикацией [Error] приведет к появлению подтверждающего сообщения об 
обновлении папки, в которой сохранено выбранное изображение. 
●●Не существует зарегистрированной папки 
Удостоверьтесь в том, что папка существует с помощью Explorer или другой 
программы управления файлами. Если указанная папка регистрации находится на 
съемном устройстве, например, на внешнем жестком диске, проверьте, правильно ли 
подсоединено устройство, и выберите [View]→[Refresh] в меню.
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Проблемы и их решения (В&О)
Прочее

Подсоединение и сохранение на ПК
Симптом Проверка

Даже если Ваша цифровая камера 
подключена к ПК посредством кабеля 
USB, ПК не распознает цифровую камеру.

Вставлена ли карта памяти в Вашу цифровую камеру?
В зависимости от цифровой камеры, может оказаться необходимым установить 
цифровую камеру на подключение к ПК. За дальнейшей информацией обращайтесь к 
руководству по эксплуатации для цифровой камеры.

Неправильно отображаются 
миниатюры на экране [Copy to PC].

Движущиеся изображения, записанные на несовместимых устройствах, или движущиеся 
изображения, созданные с помощью другого программного обеспечения, невозможно отобразить в 
виде миниатюры, или же на миниатюре отображается значок “?” и их невозможно воспроизводить.

Движущееся изображение
Симптом Проверка

Невозможен показ движущегося 
изображения.

Возможен показ только тех движущихся изображений, которые были записаны цифровой камерой, 
в комплект поставки которой было включено данное ПО, либо которые были записаны с помощью 
данного ПО. (Тем не менее, движущиеся изображения в формате DVD-Video не поддерживаются.)
Движущиеся изображения, записанные цифровой камерой, в комплект поставки которой вошло данное 
ПО, но отредактированные на других устройствах или с помощью других ПО, не смогут воспроизводиться.

Некорректный показ движущегося 
изображения.

Закройте все работающие ПО.
Попытайтесь обновить драйверы устройства под звуковую карту или видеокарту.
В зависимости от функции [Windows Aero] в Windows, среды ПК или воспроизводящихся 
движущихся изображений во время показа может иметь место пропадание кадров или 
цветов или же движущееся изображение может воспроизводиться неплавно.
В местах переключения разрешения или аудио движущегося изображения возможны 
звуковые шумы или прерывистость воспроизведения. В зависимости от рабочей среды ПК, 
частота кадров может уменьшиться для обеспечения непрерывности воспроизведения.

Невозможно воспроизводить 
панорамные изображения, 
сохраненные в формате QuickTime.

Изображения невозможно воспроизводить, если они не связаны с QuickTime Player.
Щелкните правой клавишей мыши по значку в Explorer и свяжите изображение с QuickTime 
Player. После этого оно будет воспроизводиться при двойном щелчке по миниатюре.

Невозможно редактирование 
движущегося изображения.

Для редактирования или для создания носителя пригодны только движущиеся изображения 
или неподвижные изображения с ПК. Сначала скопируйте снимки с носителя на ПК.

Указанный кадр не так редактируется. Для некоторых движущихся изображений кадры, указанные в операциях редактирования, 
могут не так редактироваться.

Невозможен доступ к приводу с помощью 
другого ПО, например, Explorer.

Используемый данным ПО привод является недоступным для других ПО. Закройте 
данное ПО перед осуществлением доступа с помощью других ПО.
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Проблемы и их решения (В&О)
Прочее

Симптом Проверка

Невозможно форматирование дисков 
DVD-RAM/RW, записанных с помощью 
данного ПО.

Диски DVD-RAM/RW, записанные с включенной автоматической защитой, заданы как 
защищенные, поэтому их форматирование с помощью другого ПО для записи DVD или с 
помощью Explorer будет невозможным.
В этом случае следует снять защиту путем форматирования диска посредством данного 
ПО, что позволит дальнейшее форматирование и другими ПО. ([Complete erasure] 
занимает продолжительное время, поэтому рекомендуется использование [Simple erasure])

Невозможно добавление данных для 
движущихся изображений AVCHD/
AVCHD Lite.

Добавление данных возможно толко на такие носители:
●●DVD-RAM или карту памяти, записанные с помощью данного ПО.
●●Карту памяти, записанную на совместимой цифровой камере.

Невозможна запись на CD/DVD.

Необходим накопитель CD/DVD, совместимый со стандартной программой-мастером 
записи для Windows.
Если ярлык [Recording] не отображается в [Properties] для Вашего накопителя CD/DVD, 
значит накопитель несовместим с программой-мастером записи и не может использоваться.
Windows XP совместима только с записью на CD.

Невозможно распознать оптический 
диск в опции [Copy to Media].

Если Вы вошли в Windows XP как пользователь с ограниченным доступом и вставили 
оптический диск в накопитель, он не будет распознан. Войдите как пользователь с 
полномочиями системного администратора перед тем, как вставлять диск.

При записи движущегося изображения 
AVCHD/AVCHD Lite выдается ошибка.

Возможны следующие причины.
●●Это несовместимый носитель.
●●В случае карты памяти она не была отформатирована в совместимой файловой системе.

	�Отформатируйте карту памяти на совместимой цифровой камере. (Все 
записанные данные будут удалены.)

●●Несовместимые накопитель и диск.
	�Используйте диск, рекомендуемый для накопителя. 
(Некоторые диски могут не воспроизводиться даже в случае правильного 
завершения записи. Включите подтверждение воспроизведения после записи.)

●●Подвержено влиянию состояния накопителя, на котором установлена ОС, или 
накопителя, указанного как рабочее поле.

	�Необходима дефрагментация.
Для дефрагментации выберите [Computer] (My Computer) в меню Start, 
выполните правый щелчок по иконке накопителя жесткого диска и выберите 
[Properties] → [Tools] → [Defragment Now] → [Defragment now]. Однако не 
выполняйте дефрагментацию во время работы программного обеспечения.
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Проблемы и их решения (В&О)
Прочее

Симптом Проверка

При записи движущегося изображения 
AVCHD/AVCHD Lite выдается ошибка.
(Продолжение)

●●Работает другое программное обеспечение.
	�Выйдите. Это может привести к сбою записи или повреждению диска.
(В частности, программного обеспечения для записи DVD или CD или 
программ, которые используют много памяти, например, для записи 
движущихся изображений или программного обеспечения кодирования.)

●●Программное обеспечение, которое использует накопители, например, программное 
обеспечение записи на DVD другой компании или программное обеспечение для 
пакетной записи, или установленный накопитель ASPI.

	�Удалите все виды подобного программного обеспечения и накопителей и 
повторно установите это программное обеспечение.

●●Установлено другое программное обеспечение с функцией считывания дисков UDF.
	�Временно остановите выполнение функции или удалите другое программное 
обеспечение с функцией считывания дисков UDF.

●●Подсоединено несколько программ аппаратных средств.
	�Отсоедините другие устройства USB, например, устройство для считывания карт памяти 
SD, и проверьте работу. (Особенно при записи с использованием внешних накопителей.)
Однако не подсоединяйте и не отсоединяйте во время записи.

●●С помощью соединения USB подсоединена видеокамера, накопитель, жесткий диск или 
адаптер карты памяти SD.

	�Используйте другой порт USB. (Например, порт USB на задней стороне ПК.)
●●Влияние встроенного программного обеспечения накопителя (управляющей 
программы, записанной на основное устройство).

	�Обновите встроенное программное обеспечение ПК и накопителя до последних версий. 
(Обновления встроенного программного обеспечения могут иметься на веб-сайтах.)

●●Влияние стандартной функции ОС для записи на CD.
	�Отмените эту функцию.

Запись невозможна. Движущееся изображение AVCHD/AVCHD Lite продолжительностью менее 2 секунд не 
может записываться на диск.
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Симптом Проверка

Появляется сообщение о 
превышении допустимого предела, 
при этом запись невозможна.

Запись невозможна, потому что количество движущихся изображений превысило 
предельное значение, допускаемое для стандарта AVCHD или этого программного 
обеспечения.
- Максимальное количество движущихся изображений AVCHD/AVCHD Lite: 3950
- �Максимальное количество движущихся изображений AVCHD/AVCHD Lite, записанных в 

один день:  
(Для карты памяти) 4000  
(Для DVD) 999

Однако допустимое число записываемых видео может оказаться меньше числа сцен с 
различными режимами записи в пределах одного видео.

При указании привода назначения 
появляется сообщение об ошибке.

Закройте другое ПО, используя привод.
Сообщение об ошибке может появиться при смене носителя. Снова выберите привод. 
В случае конфликта с другим записывающим ПО деинсталлируйте его.

Нарушения в снимке при записи, 
корректная запись невозможна. Выйдите из этого ПО и перезапустите ПК.

Невозможна запись на носитель, 
отформатированный с помощью 
Explorer на ПК.

Если запись на диск будет проводиться с помощью этого ПО, отформатируйте его с 
помощью его же. Невозможно использование дисков, отформатированных с помощью 
отличных от данного ПО (напр., Explorer).
Отформатируйте карту памяти на цифровой камере, совместимой с данным ПО.

Невозможна запись на фирменный 
новый DVD-RAM.

Находящиеся в продаже DVD-RAM отформатированы в формате UDF 2.0, поэтому для 
записи по стандарту AVCHD их необходимо отформатировать в UDF 2.5 с помощью этого 
ПО.

Невозможно ничего добавить на DVD-
RAM.

На диске с установленной защитой запись невозможна. Снимите защиту с помощью 
того устройства, с помощью которого она была установлена. Добавление (без удаления 
защиты) также возможно на диски, записанные по стандарту AVCHD, при условии 
включенной настройки автоматической защиты.

Невозможна остановка записи. Запись на дисках DVD-R/RW можно остановить, щелкнув по [Cancel] на этапе 
конвертировании данных, однако ее невозможно остановить на этапе записи данных.

Появляется сообщение об ошибке диска. Запись невозможна, если диск или форматирование несовместимы со стандартом 
записи.
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Воспроизведение на других устройствах
Симптом Проверка

Структура движущегося изображения 
становится расплывчатой или 
появляются шумы.

При конвертировании быстро движущихся изображений, записанных в формате DVD-
Video, их структура может стать расплывчатой или появляются шумы. Чтобы исправить 
ситуацию, установите качество снимка для конвертирования на [Picture quality priority] в 
окне [Motion detection settings]. 

Движущиеся изображения 
с форматом кадра 16:9 
воспроизводится в формате 4:3.

Движущееся изображение MPEG2 с форматом кадра 16:9 может воспроизводиться на  
Windows Media Player и т.п. в формате 4:3.

При воспроизведении созданного 
диска на других устройствах 
структура движущегося изображения 
не показано.

При воспроизведении на некоторых устройствах, например, на телевизоре, часть 
структуры движущегося изображения может не отобразиться.

Невозможно воспроизведение карт 
памяти или дисков, созданных по 
стандарту AVCHD. 

Диски или карты памяти стандарта AVCHD, созданные с помощью данного ПО, могут 
воспроизводиться только на совместимых с данным форматом устройствах.

Невозможно воспроизведение 
созданного диска.

Воспроизведение должно выполняться на устройствах, поддерживающих данный тип 
диска.

На несколько секунд прерывается 
воспроизведение карты памяти 
или диска, созданных по стандарту 
AVCHD.

При воспроизведении записи, сделанной на носителе, возможно ее прерывание между 
сценами на несколько секунд.

Невозможно воспроизведение 
носителей, созданных в формате 
DVD-Video, на Windows Media Player.

Аудио записанных на носителях файлов MPEG2 выполнено в формате Dolby Digital. Звук 
не воспроизводится, если не установлен кодек Dolby Digital.

При проигрывании созданного диска 
последнее движущееся изображение 
слегка обрезается.

При записи в формате DVD-Video последнее движущееся изображение может оказаться 
на 0,5 сек короче.

Невозможен просмотр созданного 
носителя через Explorer.

При записи носителей в стандарту AVCHD используется файловая система в формате 
UDF 2.5, поэтому без установленного для UDF 2.5 привода их просмотр на ПК 
невозможен.



143

Проблемы и их решения (В&О)
Прочее

GPS
Симптом Проверка

Изображения не показываются 
после переключения на отображение 
названия места.

На отображении названия места могут быть показаны только изображения, записанные с 
помощью цифровой камеры Panasonic с включенной функцией GPS.
Изображения, записанные с помощью цифровой камеры, имеющей функцию GPS других 
производителей, не могут быть показаны на отображении названия места.
Кроме того, изображения, для которых информация названия места была удалена 
с помощью данного программного обеспечения, не показываются. Для проверки 
изображений после удаления информации названия места переключитесь на показ 
папки.

Удаление информации названия 
места невозможно. 
(Пункт меню затенен.)

Невозможно удалить информацию названия места с изображений и движущихся 
изображений без информации GPS (включая изображения, для которых информация 
названия места была удалена с помощью данного программного обеспечения).
Также невозможно удалить информацию названия места, выбирая несколько 
изображений на отображении названия места. Выберите одно изображение и вызовите 
меню правым щелчком.
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Серия
Симптом Проверка

Вы хотите указать неподвижное 
изображение, которое будет 
использовать для слайд-шоу во 
время группового отображения.

Заранее установите неподвижное изображение, которые Вы хотите указать как 
избранное. Однако имейте в виду, что если более одного неподвижного изображения 
установлено как избранное, выбирается изображение, установленное как избранное, 
которое ближе всего к первому изображению в группе.

Неподвижные изображение не 
отображаются как часть одной и той 
же серийной группы.

В следующих случаях неподвижные изображения не распознаются как часть одной и той 
же серийной группы.

●●Когда неподвижные изображения записаны с помощью цифровой камеры, отличной от 
той, к которой прилагалось данное программное обеспечение
●●Изображения, записанные в разные времена
●●При перемещении изображения из группы в другую папку
●●При удалении информации, задающей серийные изображения, например, во время 
редактирования неподвижного изображения

Вы не хотите показывать 
неподвижные изображения как часть 
одной серийной группы.

Если неподвижные изображения, записанные в режиме серии, копируются или 
редактируются и сохраняются в ту же самую папку, что и исходное неподвижное 
изображение, то они могут рассматриваться как часть одной серийной группы.
Если Вы не хотите показывать такие неподвижные изображения как часть одной 
серийной группы, укажите в качестве места назначения сохранения другую папку, 
отличающуюся от папки, содержащей исходное неподвижное изображение.



145

Проблемы и их решения (В&О)
Прочее

Прочее
Симптом Проверка

Невозможно запустить приложение.

Проверьте установку разрешения дисплея и используйте установку дисплея 1024x768 
или выше.
Также, если размер шрифта текста установлен на значение, превышающее 100% по 
умолчанию, необходимо уменьшить размер шрифта или нужно изменить установку 
дисплея на еще большее разрешение.

Медленный запуск приложения. Запуск может быть замедлен на ПК, которые не подсоединены к Интернету.
Проверьте, может ли ПК подсоединиться к Интернету. 

Загрузка на YouTube может 
выполняться ненадлежащим 
образом.

Убедитесь в том, что информация для входу в систему (имя пользователя или пароль) не 
является ошибочной.
Убедитесь в подсоединении ПК к интернету.
Убедитесь, что резидентное ПО, как, например, антивирусное ПО и брандмауэр и пр., не 
заблокировали доступ к YouTube.
Проверьте сайт YouTube.

Если движущееся изображение 
начинает записываться в один день 
и заканчивается в другой, что будет 
считаться “датой записи”?

“Датой записи” считается день начала записи движущегося изображения.

Появляется сообщение о 
недостаточной памяти.

Сообщение о недостаточной памяти может появиться при работе с большими объемами 
движущихся или неподвижных изображений. В этом случае инсталлируйте больше 
памяти (проблема решаема путем увеличения виртуальной памяти). За информацией 
об инсталляции большей памяти или об увеличении виртуальной памяти обратитесь, 
пожалуйста, к изготовителю ПК.

Медленное отображение миниатюры. Дефрагментация накопителя, на котором содержится файл, может улучшить 
производительность.
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Глоссарий
●●Формат AVCHD 
Этот стандарт предназначен для записи и воспроизведения 
видео высокой четкости.
Некоторые цифровые камеры могут записывать движущиеся 
изображения AVCHD или AVCHD Lite. Затем с помощью этого 
программного обеспечения такие движущиеся изображения можно 
копировать в формате с высокой четкостью на карту памяти или DVD. 
(Воспроизведение возможно на устройствах, совместимых с AVCHD.)

●●Формат MPEG2 
Формат сжатия данных изображения и часть стандарта MPEG. 
С помощью настоящего программного обеспечения движущиеся 
изображения AVCHD или AVCHD Lite можно преобразовать к 
формату MPEG2 со стандартным качеством изображения.

●●DPOF
DPOF обозначает Digital Print Order Format (Формат 
цифровых данных для печати), и является стандартом для 
записи информации о печати на карту памяти. Возможно его 
использование в DPOF-совместимой карте памяти, принтере.

●●DVD-Video
Этот формат можно использовать для воспроизведения на 
обычных проигрывателях DVD.
С помощью этого программного обеспечения движущиеся 
изображения, которые были записаны в формате AVCHD или AVCHD 
Lite, можно преобразовывать в формат DVD-Video для создания DVD.

●●Exif
Exif представляет собой аббревиатуру слов Exchangeable 
Image File Format.
Данный формат помимо самого снимка содержит 
дополнительную информацию в файле формата JPEG 
или TIFF. Может быть записана такая информация, как 
миниатюра, время и дата записи, название цифровой камеры, 
фокусное расстояние, диафрагма, выдержка, баланс белого, 
информация GPS (информация о положении) и прочие данные.
Используя информацию Exif, PHOTOfunSTUDIO может 
автоматически отсортировать файлы и распечатать дату записи.

●●Exif Print (Exif2.2)
Псевдоним Exif2.2
Exif2.2 относится к технологии достоверной печати данных, 
записанных на цифровой камере, на принтере.
Если Вы имеете принтер и цифровую камеру, совместимые 
с Exif2.2, Вы можете настроить принтер на обращение к 
информации о снимке и на отражение данной информации 
на отпечатках.

●●PRINT Image Matching
Данная технология, предложенная компанией Seiko Epson 
Corporation, обеспечивает совместную работу цифровых 
камер и принтеров.
Если у Вас есть совместимые цифровая камера и принтер, 
Вы можете более четко выразить условия во время записи и 
замысел фотографа при печати.

●●Связанный файл
В PHOTOfunSTUDIO два файла, связанные друг с другом, 
называются “связанные файлы” (например, файлы формата 
JPEG и MOV, файлы формата JPEG и TIFF и т.д.).
Два файла, удовлетворяющие следующим условиям, могут 
считаться связанными:
- Они находятся в той же самой папке.
- Их имена одинаковы за исключением расширения.
- Их имена совместимы со стандартами DCF*.
*	�Данное ПО признает файл совместимым со стандартами 

DCF, если его имя состоит из основного имени из 8 
однобайтовых символов и расширения из 3 однобайтовых 
символов, при этом первые 4 символа основного 
имени являются буквенно-цифровыми заглавными 
однобайтовыми символами или символом “_”, а последние 
4 символа являются номером от 0001 до 9999. 
(DCF - это аббревиатура формата записи “Design rule for 
Camera File system”, который соответствует стандарту 
файловой ситсемы, принятому ассоциацией JEITA (Japan 
Electronics and Information Technology Industries Association).)
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Торговые марки и лицензионные соглашения
●●Microsoft®, Windows®, Windows Vista® и DirectX® являются либо зарегистрированными торговыми марками, либо торговыми марками 
корпорации Microsoft Corporation в США и/или других странах.
●●IBM® и PC/AT являются зарегистрированными торговыми марками Корпорации International Business Machines Corporation в США.
●●Intel®, Core™ и Pentium® являются зарегистрированными торговыми марками или торговыми марками корпорации Intel Corporation в 
США и в других странах.
●●QuickTime и торговый знак QuickTime являются торговыми марками или же зарегистрированными торговыми марками компании 
Apple Inc., используемыми по лицензии.
●●YouTube является товарным знаком корпорации Google.
●●“AVCHD” , “AVCHD Lite”, логотип “AVCHD” и логотип “AVCHD Lite” являются торговыми марками Panasonic Corporation и Sony 
Corporation.
●●Изготовлено по лицензии компании Dolby Laboratories.  
Долби и знак в виде двойной буквы D являются товарными знаками компании Dolby Laboratories.  
Конфиденциальный непубликуемый продукт. Авторское право Dolby Laboratories, 1993-1998. Все права защищены.
●●Скрин-шот(ы) Microsoft перепечатаны с разрешения корпорации Microsoft.
●●Прочие названия систем и продуктов, упоминаемых в данном руководстве, являются как правило зарегистрированными торговыми 
марками или же торговыми марками производителей, разработавших данные системы или продукты.
●●Этот продукт выпускается по лицензии согласно патентному портфелю AVC для личного и некоммерческого использования 
потребителем с целью (i) кодирования видеозаписей в соответствии со стандартом AVC (“Видео AVC”) и/или (ii) декодирования 
видеозаписей AVC, закодированных потребителем в ходе личной некоммерческой деятельности и/или полученных от провайдера 
видеоинформации, имеющего разрешение на предоставление видеозаписей AVC.  
Использование с иными другими целями, прямо или косвенно, не разрешается.  
Для получения дополнительной информации обращайтесь в компанию MPEG LA, LLC.  
См. http://www.mpegla.com.
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